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Welcome

Figure 1: DDR5

Figure 2: LPDDR5-5X

DDR (Dual Data Rate) is a dominant and fast-growing memory technology. It offers high data transfer rates required for virtually all
computing applications, from consumer products to the most powerful servers. The high speed of these signals require high performance
measurement tools.

Welcome
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The Tektronix TekExpress DDR Tx is an automated test application that supports DDR5 and LPDDR5-5X to validate and debug design of
the respective DUT as per the latest JEDEC specification. The solution enables you to achieve new levels of productivity, efficiency, and
measurement reliability.

Key features for LPDDR5-5X
1. Supports 158 measurements of LPDDR5-5X System Transmitter Tests as per LPDDR5 JEDEC specification:

• 33 Clock measurements
• 11 Write Clock measurements
• 58 Write Data measurements
• 1 Write Data tDQ2DQ measurement
• 30 Read Data measurements
• 13 CA Rx Specification measurements
• 12 CS Rx Specification measurements

2. Number of UIs support for Clock, Write Clock, Write Data and Read Data measurements.
3. Hexagonal shape mask and margin analysis.
4. Single Ended mode support.

Key features for DDR5
1. Performance improvement in overall test execution time when all tests are selected.
2. Single Acquire Type for CLOCK, DATA [Write], DATA [READ], CA measurements; group wise and Analyze.
3. Automatic calculation of amplitude for Read Write Burst detection.
4. Total 58 Measurements of DDR5 System Transmitter Tests as per DDR5 JEDEC Specification:

• 21 Clock measurements
• 13 Write Burst measurements
• 16 Read Burst measurements
• 08 Command and Address measurements

5. Number of UIs support for Clock and Read/Write Data measurements.
6. Diamond shape mask and margin analysis for Write Data Eye measurement
7. DDR DFE: Deploys 'DDR DFE' Standalone application, that can be launched from TekScope > Analyze > DDR DFE
8. Support DFE for Write Data Eye measurements
9. DDR DFE: Added Threshold "Auto" option selection.
10. DDR DFE: Increased the record length capability for continuous signal.
11. Noise Compensation support for Clock measurements.

Key features applicable for both DDR5 and LPDDR5-5X
1. De-embedding support applicable as per respective signal type in both Devices.
2. User Defined Acquisition support for all signal types respectively in both Devices.
3. Multi-Run feature is applicable for all tests in both Devices.
4. All tests are De-selected by default in Test Selection tab.
5. All acquisition sources are De-selected by default in Acquisition panel.
6. Enabled de-embedding and TriMode probe support in User Defined Acquisition (UDA).
7. Acquire parameters like Record Length and Sample Rate are moved to Global Configurations.
8. Save worst case waveform in known / TekExpress sessions.
9. Retain Vertical Scale settings supported during acquisition.

Welcome
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10. Visual trigger setup file support in Visual Search.
11. User friendly measurement configurations.
12. Test Report to reflect all the statistics of the measurement.
13. User can select the source and channel in acquisition panel.
14. Voltage settings moved into common location for easy access.
15. Multiple Burst Detection Method supported - Read and Write, Write Only, Read Only, Visual Search.
16. Custom Data Rate support upto 15000MT/s.
17. Integrated with new TekExpress Framework v5.8.0.71, which adds improved GUI for 'Results Panel - shows statistics in detail',

'Report Panel', 'pre-recorded mode' and 'multiple configurations / sessions' in same Test Setup.
18. Limits will be updated per measurements as per Data Rate selected.
19. Limits for Custom Data Rate will be updated to closest data rate of the measurements.
20. Save-Recall-Limits features added.
21. Show only results option added for Test Report.
22. Test Report will show the 'Signal' type for the executed measurements on respective 'Source'.
23. Test report reflects supported JEDEC specification version.

Welcome
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Getting help and support

Product documents

Use the product documents for more information on the application functions, understand the theory of operation, how to remotely program
or operate the application, and do other tasks.

Table 1: TekExpress Application documents

To learn about Use this document
How to use the application

How to remotely control the instrument
TekExpress <Application Name> Help

PDF version of this document can be downloaded from www.tek.com/downloads

Compiled HTML (CHM) version is integrated with the application. Press F1 key from the
keyboard to start the help.

Tektronix Part Number: 077-xxxx-xx

Conventions
This application help uses the following conventions:

• The term "Application," and "Software" refers to the TekExpress Application.
• The term “DUT” is an abbreviation for Device Under Test.
• The term “select” is a generic term that applies to the two methods of choosing a screen item (button control, list item): using a mouse

or using the touch screen.
• A Note identifies important information.

Table 2: Icons used in the help

Icon Description
This icon identifies important information

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the application more
efficiently.

Getting help and support
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Technical support
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix at the front of this
document for contact information.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible): 

General information
• All instrument model numbers
• Hardware options, if any
• Modules used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save the setup files for all the instruments used and the application
• If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file

Getting help and support

TekExpress® DDR Tx Software Printable Application Help 11



Getting started
Hardware requirements

Supported oscilloscope models
• MSO71604DX, MSO72004DX, MSO72304DX, MSO72504DX, and MSO73304DX.
• DPO71604DX, DPO72004DX, DPO72304DX, DPO72504DX, and DPO73304DX.
• DPO71604SX, DPO72004SX, DPO72304SX, DPO72504SX, and DPO73304SX.
• Non-ATI channels of DPO75002SX, DPO75902SX, DPO7702SX, DPS75004SX, DPS75904SX, and DPS77004SX.

Recommended probes
Active probes:

• P7720 20 GHz Trimode Probe with TekFlex connector technology
• P7716 16 GHz Trimode Probe with TekFlex connector technology

Probe tips:

• P77STFLXA / P77STCABL: Active, Solder-in Tip with TekFlex connector technology; probe tips to probe directly on the motherboard
or vias.

• P77STFLXB / P77STCABL / P77STLRCB: Active, Solder-in Tip with TekFlex connector technology:

DDR5: Probe tips to probe CLK, DQS, DQ, and CA on the Nexus XH Series SI Interposer.

LPDDR5-5X: Probe tips to probe CLK, WCK, RDQS, DQ, CA, and CS on the Nexus XH Series SI Interposer.
• P77STFLRA: Active, long reach solder-in tip with TekFlex connector technology.
• P77HTFLRA: Active, long reach high temperature solder-in tip with TekFlex connector technology.
• P77STFLRB: Active, long reach 55 Ω Solder-in tip with TekFlex Connector technology for DDR/LPDDR electrical Validation with

interposers.
• P77HTFLRB: Active, long reach 55 Ω Solder in tip with TekFlex Connector technology for high-temperature DDR/LPDDR electrical

Validation with interposers (up to 125 ºC).

Recommended SI Interposers
Edge Probe, Direct Attach, Socketed interposer available from Nexus. Please order directly from Nexus. Please request the s-par files for
all individual signals on the interposer instead of getting a generic nominal s-par model.

Refer the Nexus's page for more information, www.nexustechnology.com/products/memory-interposers/ddr5-main-memory-interposers/ for
DDR5 and www.nexustechnology.com/products/memory-interposers/lpddr5-mobile-memory-interposers/ for LPDDR5-5X.

Software requirements

Required software
• LPDDR5SYS: LPDDR5 Memory Bus Electrical Validation and Analysis Oscilloscope Software.
• DDR5SYS: DDR5 Memory Bus Electrical Validation and Analysis Oscilloscope Software.
• SDLA64: Serial Data Link Analysis for Win 64-bit Scopes.
• DJA: DPOJET Jitter Analysis.

Getting started
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• VET: VET – Visual Trigger.

Downloading and installing the software
Complete the following steps to download and install the latest TekExpress <Application Name> application.

1. Go to www.tek.com.
2. Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as Software and enter the application name in the MODEL OR

KEYWORD field and click SEARCH.

3. Select the latest version of software and follow the instructions to download the software. Copy the executable file into the
oscilloscope.

4. Double-click the executable and follow the on-screen instructions.

The software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress <Application
Name>.

5. Select Application > TekExpress <Application Name> from the Oscilloscope menu, to open the application.

Activate the license
Activate the license using the Option Installation wizard in the TekScope application:

1. In the TekScope application menu bar, click Utilities > Option Installation. The TekScope Option Installation wizard opens.
2. Push the F1 key on the oscilloscope keyboard to open the Option Installation help topic.
3. Follow the directions in the help topic to activate the license.

View software version and license key details
To view version information of the application, click Options > About TekExpress.

Getting started
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Setting up the test environment

Search instruments connected to the application
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. The
application uses TekVISA to discover the connected instruments.

Note: The instruments required for the test setup must be connected and detected by the application, before running the test.

To refresh the list of connected instruments:

1. Select Options > Instrument Control Settings.
2. In the Search Criteria section of the Instrument Control Settings dialog box, select the connection types of the instruments to

search. Instrument search is based on the VISA layer, but different connections determine the resource type, such as LAN, GPIB, and
USB. For example, if you choose LAN, the search will include all the instruments supported by the TekExpress that are communicating
over the LAN.

3. Click Refresh. The TekExpress application searches for the connected instruments.

Figure 3: Search status of the instruments connected to LAN

4. When the search is complete, a dialog box lists the instrument-related details based on the search criteria. For example, for the Search
Criteria as LAN and GPIB, the application displays all the LAN and GPIB instruments connected to the application.

Figure 4: TekExpress Instrument Control Settings window

The details of the instruments are displayed in the Retrieved Instruments table. The time and date of instrument refresh is displayed in
the Last Updated field.

Setting up the test environment
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Compensate the signal path (Prerequisite)
Use the following procedure to compensate the internal signal acquisition path. Perform this procedure if the ambient temperature has
changed more than 5 °C (9 °F) since you performed the last signal path compensation. Perform the signal path compensation once a
week. Failure to do so may result in the instrument not meeting warranted performance levels. 

1. Power on and wait for the instrument to complete its warm up period before continuing with this procedure.
2. Disconnect any probes you have connected to the input channels.
3. Set the instrument to Menu mode.
4. Select Instrument Calibration from the Utilities menu.
5. Note any instructions that appear in the resulting control window.
6. Click Run SPC to begin the procedure. The procedure may take several minutes to complete.
7. Verify that the Status changes to Compensated after the procedure is complete. If the Calibration Status field indicates anything other

than Compensated, see Signal Path Compensation Status for information on the readout and recommended action.

Note: When making measurements at vertical scale settings less than or equal to 5 mV, you should perform the signal path
compensation at least once a week. Failure to do so may result in the instrument not meeting warranted performance levels at
those volts/div settings.

Running tests
DUT: Set DUT settings on page 23 , Select tests, Acquisitions: Set waveform acquisition settings on page 34, Configuration: Set
measurement limits for tests on page 36, Preferences: Set the test run preferences on page 41, and click Start to run the tests. While
tests are running, you cannot access the Setup or Reports panels. To monitor the test progress, switch between the Status panel and the
Results panel. 

While tests are running, the other applications will be displayed at the background. If you want the TekExpress DDR Tx application to run in
the foreground select Keep On Top from the TekExpress Options menu.

The application displays report when the tests execution is complete.

Pre-run checklist
1. Make sure that the instruments are warmed up (approximately 20 minutes) and stabilized.
2. Perform compensation: In the oscilloscope main menu, select Utilities > Instrument Compensation. Click Help in the compensation

window for steps to perform instrument compensation.

View test results
When a test completes, the application switches to the Results panel, which shows a summary of test results.

Each test result occupies a row in the Results table. By default, results are displayed in summary format, with the measurement details
collapsed. You can change the view in the following ways: 

• To view the results grouped by lane, test, or data rate, select the corresponding item from the Preferences menu.
• To expand all tests listed, select View Results Details from the Preferences menu.
• To expand and collapse tests, use the plus and minus buttons to the left of the test rows.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
• To expand the width of a column, place the cursor over the vertical line that separates the column from the one to the right. When the

cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.
• To sort the test information by column, click the column head. When sorted in ascending order, a small up arrow is displayed. When

sorted in descending order, a small down arrow is displayed.

Setting up the test environment

TekExpress® DDR Tx Software Printable Application Help 15



• To clear all test results displayed, click Clear ( ).

Setting up the test environment
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Starting the application
To start the TekExpress <application name>, select Applications > TekExpress <application name> from the oscilloscope menu bar.

During start, a "My TekExpress" folder is created in the Documents folder of the current user and gets mapped to "X" drive. When the
application is closed properly, the "X" drive gets unmapped. Session files are then stored inside the X:\<Application Name>
folder. If this file is not found, the application runs an instrument discovery program to detect connected instruments before starting
TekExpress <application name>.

Starting the application
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To keep the TekExpress <application name> application on top of any application, select Keep On Top from the options menu. If the
application goes behind the oscilloscope application, select Applications > TekExpress <application name> to bring the application to
the front.

Application controls
This section describes the application controls.

Table 3: Application control description

Item Description
Options menu Menu to display global application controls.

Test panel Controls that open tabs for configuring test settings and options.

Start / Stop button Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set.

The button toggles to the Stop mode while tests are running. Use the Stop button to abort
the test.

Pause / Continue button Use the Pause button to pause the acquisition. When a test is paused, this button changes
as Continue.

Clear button Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or
sets of statistics that are not coherent. This button is available only on Results panel: View
summary of test results on page 47.

Note: This button is visible only when there are results data on the panel.

Application window move icon Place the cursor over the top of the application window to move the application window to
the desired location

Minimize icon Minimizes the application.

Close icon Close the application.

Table continued…

Starting the application
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Item Description
Mini view / Normal view Toggles the application between mini view and normal view.

Mini view displays the run messages with the time stamp, progress bar,

Start / Stop button, and Pause / Continue button.

The application moves to mini view when you click the Start button.

Starting the application
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Options menu functions
To access the Options menu, click  in the upper-right corner of the application. It has the following selections:

Options menu

Table 4: Options menu settings

Menu Function
Default Test Setup Opens a new test setup with default configurations.
Open Test Setup Opens a previously saved test setup. Displays the list of previously saved test setup file

names. Make the selection and click OK to open the test setup.
Save Test Setup Saves the current test configurations with the specified file name.
Save Test Setup As Saves the current test setup with a different file name or file type.
Open Recent Displays the recently opened test setup file names. Make the selection and click OK to

open the test setup.
Instrument Control Settings Detects, lists, and refreshes the connected instruments found on the specified connections

(LAN, GPIB, USB, Serial, Non-VISA Resources, TekLink, and VXI).

Keep On Top Always keeps the TekExpress <application name> application on top of all the applications.

Email Settings Configures email options for test run and result notifications.
Help Displays the TekExpress <Application Name> help.
About TekExpress Displays the application name, version, and hyperlink to end the user license agreement.

Starting the application
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Configure email settings
Use the Email Settings utility to get notified by email when a measurement completes or produces any error condition. Follow the steps to
configure email settings: 

Figure 5: Email settings window

1. Select Options > Email Settings to open the Email Settings dialog box.
2. (Required) For Recipient email Address(es), enter one or more recipient email addresses. To include multiple addresses, separate

the addresses with commas.
3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name,

followed by an underscore, followed by the instrument serial number, then the @ symbol, and the email server ID. For example:
user@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location,
and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

Note: If any of the above required fields are left blank, the settings will not be saved, and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

• Reports: Select to receive the test report with the notification email.

• Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you
want to receive the full log or just the last 20 lines.

6. In the Email Configuration section:

• Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is
5 MB.

• Enter the number in the Number of Attempts to Send field, to limit the number of attempts that the system makes to send a
notification. The default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email
notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.

Starting the application
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Setup panel: Configure the test setup
The Setup panel contains sequentially ordered tabs that help you guide through the test setup and execution process.

Figure 6: DDR5

Figure 7: LPDDR5-5X

Setup panel: Configure the test setup
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DUT: Set DUT settings
Use the DUT tab to select parameters for the device under test. These settings are global and apply to all tests of current session. DUT
settings also affect the list of available tests in the Test Selection tab.

Figure 8: DDR5

Figure 9: LPDDR5-5X

Click Setup > DUT to access the DUT parameters: 

Setup panel: Configure the test setup
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Table 5: DUT tab settings

Setting Description

Acquire live waveforms Acquire active signals from the DUT for measurement and analysis.
Use pre-recorded waveform files Run tests on a saved waveform.

Click here for details about the file names for pre-recorded waveform.

User Defined Acquisition When selected, enables user to define the acquisition settings of their choice. Gives additional source
option [MATH] for signals in acquisition panel.

DUT ID Adds an optional text label for the DUT to reports. The default value is DUT001. The maximum number
of characters is 32.

You cannot use the following characters in an ID name: (.,..,...,\,/:?”<>|*)

   Comments icon (to the
right of the DUT ID field)

Opens Comments dialog box to enter text to add to the report. Maximum size is 256 characters. To
enable or disable comments appearing on the test report, see Select report options..

Device Select Device name as DDR5/LPDDR5-5X from drop-down.

Device Profile

Data Rate (MT/s) Select the data rate from drop down.

WCK:CK (Available only when Device = LPDDR5-5X)

WCK:CK is the WCK:CK ratio and is user selectable as either 2:1 or 4:1. By default it is set to 4:1.
WCK Frequency (MHz) (Available only when Device = LPDDR5-5X)

Displays the write clock frequency of the DUT, based on the selected Data Rate and WCK:CK Ratio.
Clock Frequency (MHz) (Available only when Device = LPDDR5-5X)

Displays the clock frequency of the DUT, based on the selected Data Rate and WCK:CK Ratio.

Burst detection method Selects the burst detection method from drop-down.

• Read Write Bursts
• Write Only Bursts
• Read Only Bursts
• Visual search

Signal Probe Type Selects the probe type Clock, DQS, and WCK/RDQS to execute the tests.

• Clock - Differential or Single Ended
• DQS - Differential or Single Ended
• WCK/RDQS - Differential or Single Ended (Only available when Device = LPDDR5-5X)

Table continued…

Setup panel: Configure the test setup
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Setting Description

Figure 10: DDR5

Figure 11: LPDDR5-5X

You can configure the signal as per the probes you are planning to use to run the tests.

For Device=DDR5 and Signal type=Clock: If probes are connected in a single-ended fashion, then
internally a differential signal is created to perform clock jitter measurements.

For Device=LPDDR5-5X and Signal type=Clock or WCK: If probes are connected in a single-ended
fashion, then internally a differential signal is created to perform clock or write clock measurements
respectively.

Based on the probe type selected for Clock or DQS, the test selection panel refreshes the
measurements in clock and data group.

Filter Files path Select Enable or Disable from the drop-down list.

Click Setup ( ). Browse and select the filter files from the De-Embed Filter File Path menu
for respective signals as per the probing type you use for Differential and Single-Ended signals. Click
Close to close the menu.

Table continued…

Setup panel: Configure the test setup
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Setting Description

TriMode Probe Setup With TriMode probing, one probe setup makes differential, single-ended, and common mode
measurements accurately.

Click Setup. In TriMode Probe Mode window, select A, B, or Differential from the drop-down list.

• A represents that probe is configured to point A and ground.
• B represents that probe is configured to point B and ground.
• Differential represents that the probe is configured to point A and B respectively.

Figure 12: TriMode Probe Mode window for DDR5

Table continued…

Setup panel: Configure the test setup
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Setting Description

Figure 13: TriMode Probe Mode window for LPDDR5-5X

Voltage Settings Open the voltage Settings setup to observe and to modify the voltage levels respectively.

Figure 14: Voltage Settings window for DDR5

Table continued…

Setup panel: Configure the test setup
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Setting Description

Figure 15: Voltage Settings window for LPDDR5-5X

VDD (V) VDD is the supply voltage for each DDR standard. For DDR5, it is 1.1 V.

• Displays JEDEC value by default.
• Select Manual to change the VDD value.

Vcent-DQ (V) Vcent_DQ is the voltage at which the cumulative eye of the pin DQx is widest.

• Displays Auto value by default.
• Select Manual to change the Vcent-DQ value from -2 V to 2 V.

Vcent-CA (V) Vcent_CA is the voltage at widest part of the eye.

• Displays Auto value by default.
• Select Manual to change the Vcent_CA value from -2 V to 2 V.

Vcent-CS (V) (Available only when Device = LPDDR5-5X)

Vcent_CS is voltage at widest part of the eye.

• Displays Auto value by default.
• Select Manual to change the Vcent-CS value from -2 V to 2 V.

VDD2 (V) (Available only when Device = LPDDR5-5X)

VDD2 is the supply voltage for each DDR standard.

• Displays JEDEC value by default.
• Select Manual to change the VDD2 value from 1.05 V to 0.9 V as per Data Rate.

VDDQ (V) (Available only when Device = LPDDR5-5X)

VDDQ is the voltage internally applied to the I/O buffer, varies from 0.5 V to 0.3 V as per Data Rate. It
is user configurable to change the value from 0 V to 5 V.

VOH (V) (Only available when Device = LPDDR5-5X)

Setup panel: Configure the test setup
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Setting Description

VOH is the output voltage swing, it can be set as VDDQ or VDDQ/2.

Note: P7700 Series TriMode Probes

With TriMode probing, one probe setup makes differential, single-ended, and common mode measurements accurately. This
unique capability allows you to work more effectively and efficiently, switching between differential, single-ended and common
mode measurements without moving the probe's connection points.

See also
Test Selection: Select the tests on page 33

Burst detection method
Burst detection is applicable only for Write Bursts and Read Bursts of the DATA group measurements. The Burst Detection Setup controls
the identification of data burst within a waveform which includes tri-state levels. For appropriately-probed signals with good signal fidelity,
adjustment to the default values are not required. For signals with poor fidelity or unusual properties, burst detection can be improved by
switching to Manual control and adjusting the detection levels.

Setup panel: Configure the test setup

TekExpress® DDR Tx Software Printable Application Help 29



The application supports the following burst detection methods:

1. Read Write Bursts: This method identifies READ and WRITE measurements that are available in the data group. Select this method
when there is a voltage difference between READ and WRITE burst peak-to-peak level.

Note: When the DUT traffic is transmitting both Read + Write bursts and if the Read burst amplitude is greater than the Write
burst amplitude, follow the below steps for burst detection by setting the ‘Burst Amplitude Levels’ as ‘Manual’.

a. Measure the Peak to Peak voltage level between the Higher burst’s and the lower burst’s using the “Cursors > Cursors On
> Cursor Type > H Bars”. Note down the middle voltage level of the two peak-peak voltages.

b. In the “TekExpress DDR Tx > DDR5 > Burst Detection Method > Read Write Bursts > Setup”, set the measured voltage
value in the Read Burst (pk-pk) (V) and Write Burst (pk-pk) (V) fields present under the Read and Write tabs respectively.

c. Select “Yes” for ‘Is Read burst (pk-pk) amplitude greater than Write burst (pk-pk) amplitude’ and “No” for ‘Is Write burst
(pk-pk) amplitude greater than Read burst (pk-pk) amplitude’ fields present under the Read and Write tabs respectively.

2. Write Only Bursts: The method identifies only write measurements that are available in the data group.

Note: Configure the DUT data traffic to ALL WRITE BURSTS mode.

3. Read Only Bursts: The method identifies only read measurements that are available in the data group.

Note: Configure the DUT data traffic to ALL READ BURSTS mode.

Table 6: Burst detection parameter description for DDR5

Pre-amble Length (tCK) Specify the Read / Write burst pre-amble length of your device here.

Post-amble Length (tCK) Specify the Read / Write burst pre-amble length of your device here.

Burst Length (UI) Specify the burst length of your device here. Used in case of Write Only Bursts or Read Only Bursts
as Burst Detection Method.

Burst Amplitude Levels Specify the burst amplitude level.

• Auto: when selected, the amplitude calculation is done automatically.
• Select Manual to enter the user defined values.

Used in case of Read Write Bursts as Burst Detection Method and must be specified in Read
and Write tabs.

Write Burst (pk-pk) (V) Specify the DQS (pk-pk) voltage level of WRITE bursts. Used in case of Read Write Bursts as Burst
Detection Method

Table continued…
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Read Burst (pk-pk) (V) Specify the DQS (pk-pk) voltage level of READ bursts. Used in case of Read Write Bursts as Burst
Detection Method

Margin (%) Specifies the voltage variance allowed in terms of percentage of peak-peak voltage. Used in case of
Read Write Bursts as Burst Detection Method.

tDQS2DQ (ps) – Auto tDQS2DQ value is automatically set by the application. Used in case of Read Write Bursts or Write
Only Bursts for 'Write' as Burst Detection Method.

tDQS2DQ (ps) – Manual tDQS2DQ value can be edited. Used in case of Read Write Bursts or Write Only Bursts for 'Write' as
Burst Detection Method.

DQ/DQS Levels Select the type of burst detection level for the search.

• Auto: The application calculates these levels for you. It is recommended unless you find that
manual levels are necessary for reliable detection.

• Manual: Enter both the Strobe and Data reference levels for the signal (High, Mid, and Low).
As you adjust the detection levels, observe the search-and-mark sprites that appear above
the waveform. These sprites are dynamically updated as you adjust the levels, helping you to
identify levels that properly delimit the selected burst type.

Note: The High/Mid/Low levels used for burst detection have no relationship to the
reference levels used for measurement points.

Edge Detection Hysteresis Configures the internal edge finder’s hysteresis band which is used to detect read or write bursts. In
the event of noisy inputs, it can be increased to correct marks which may be larger than appropriate.

Termination Logic Margin This value can be increased to help in terminating marks on back-to-back writes in cases where
otherwise a continuous strobe would cause a write-mark to merge two back-to-back writes.

Table 7: Burst detection parameter description for LPDDR5-5X

Pre-amble static (tCK)

[Write]

The write burst pre-amble static length is automatically set by the application, based on the
selection of Data Rate and WCK:CK ratio.

Pre-amble toggle (tCK)

[Write]

The write burst pre-amble toggle length is automatically set by the application, based on the
selection of Data Rate and WCK:CK ratio.

tWCK2DQI

[Write]

The Write burst tWCK2DQI value is automatically set by the application. Used in case of Write
Only Bursts or Read Write Bursts (For Write) as Burst Detection Method. To set user defined value,
select Manual option and specify the tWCK2DQI value as per your device.

Pre-amble static (tWCK)

[Read]

Specify the Read burst pre-amble static length of your device here.

Pre-amble toggle (tWCK)

[Read]

The Read burst pre-amble toggle length is set by the application automatically as per the Read
burst pre-amble static length specified by you, are as per your Device.

tDQSQ

[Read]

tDQSQ value is automatically set by the application. Used in case of Read Only Bursts or Read
Write Bursts (For Read) as Burst Detection Method. To set user defined value select Manual option
and specify the tDQSQ value as per your device.

Table continued…

Setup panel: Configure the test setup

TekExpress® DDR Tx Software Printable Application Help 31



Post-amble Mode

[Read]

Specify the Read burst Post-amble Mode either Static / Toggle of your device here.

Burst Length (UI) Specify the Read / Write burst length of your device here. Used in case of Write Only Bursts or
Read Only Bursts or Read Write Bursts as Burst Detection Method.

Post-amble Length (tWCK) Specify the Read / Write burst post-amble length of your device here.

DQ/RDQS Levels

[Read]

DQ/WCK Levels

[Write]

Select the type of burst detection level for the search.

• Auto: The application calculates these levels for you. It is recommended unless you find that
manual levels are necessary for reliable detection.

• Manual: Enter both the Strobe and Data reference levels for the signal (High, Mid, and Low).
As you adjust the detection levels, observe the search-and-mark sprites that appear above
the waveform. These sprites are dynamically updated as you adjust the levels, helping you to
identify levels that properly delimit the selected burst type.

Note: The High/Mid/Low levels used for burst detection have no relationship to the
reference levels used for measurement points.

Edge Detection Hysteresis This control configures the internal edge finder’s hysteresis band which is used to detect read or
write bursts. In the event of noisy inputs, it can be increased to correct marks which may be larger
than appropriate.

Termination Logic Margin This value can be increased to help in terminating marks on back-to-back writes in cases where
otherwise a continuous strobe can cause a write-mark to merge two back-to-back writes.

4. Visual search: Capturing and analyzing the right part of the waveform can require hours of collecting and sorting through the many
acquisitions. The Visual Trigger feature in the oscilloscope makes the identification of the desired waveform events quick and easy
by scanning through acquired analog waveforms and graphically comparing them to geometric shapes on the display. By discarding
acquired waveforms which do not meet the graphical definition, Visual Triggering extends the trigger capabilities of the oscilloscope
beyond the traditional hardware trigger system.

Visual Trigger can be used to separate Read Bursts from Write Bursts and mark them. By selecting the Visual Search option in ‘Burst
Detection Method’, these marked bursts can be used for further debugging and analysis.
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Test Selection: Select the tests
Use the Test Selection tab to select the tests. The test measurements available depends on the settings selected in the DUT. tab. 

Figure 16: TekExpress DDR Tx (DDR5) measurements

Figure 17: TekExpress DDR Tx (LPDDR5-5X) measurements

Setup panel: Configure the test setup
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Table 8: Test Selection tab settings

Setting Description

Deselect All

Select All

Deselect or select all tests in the list.

Tests Click on a test to select or unselect. Highlight a test to show details in the Test Description pane.

The application automatically selects all required tests when in Compliance mode.

Test Description Shows brief description of the highlighted test in the test tree.

See also
Acquisitions: Set waveform acquisition settings on page 34

Acquisitions: Set waveform acquisition settings
Use Acquisitions tab to view the test acquisition parameters. The contents displayed on this tab depends on the DUT type and the tests
selected.

Figure 18: Acquisition tab for DDR5

Setup panel: Configure the test setup

34



Figure 19: Acquisition tab for LPDDR5-5x

Table 9: Acquisitions tab settings

Settings Description
View Probes View the detected probe configuration. Use the View Probes dialog

box to view the connected probes.

Signal Select the type of signal on which the measurements need to be
run.

Source Select the channels with the respective signal type, on which the
measurements have to be run.

Acquisition and Save options
Save and Analyze Acquisition In Sequence Saves and then analyses the acquisition in sequence.

TekExpress DDR Tx saves all acquisition waveforms to files by default. Waveforms are saved in a unique folder for each
session (a session is started when you click the Start button). The folder path is X:\TekExpress DDR Tx\Untitled
Session\<dutid>\<date>_<time>. Images created for each analysis, XML files with result values, reports, and other
information specific to that particular execution are also saved in this folder.

Saving a session moves the session file contents from the Untitled Session folder to the specified folder name and changes the session
name to the specified name.

Setup panel: Configure the test setup
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See also
Pre-recorded waveform file names for test measurements on page 145

Configuration: Set measurement limits for tests
Use Configuration tab to view and configure the Global Settings and the measurement configurations. The measurement specific
configurations available in this tab depends on the selections made in the DUT panel and Test Selection panel.

Table 10: Configuration tab: Common parameters

Settings Description
Limits Editor Displays the upper and lower limits for the applicable measurement using different types of comparisons.

Configuration tab: Global settings

Figure 20: Configuration tab: Global Settings

Setup panel: Configure the test setup

36



Settings Description
Instruments Detected Displays the instruments connected to this application. Click on the

instrument name to open a list of available (detected) instruments.

Select Options > Instrument Control Settings and click Refresh
to update the instrument list.

Note: Verify that the LAN and GPIB search criteria
(default setting) in the Instrument Control Settings is
selected when using TekExpress DDR Tx application.

Bandwidth Select the oscilloscope bandwidth. This value is used for all tests.
Record Length Specifies the waveform record length.
Sampling Rate Specifies the oscilloscope's sample rate for all tests.
Retain Vertical Scale When enabled, retains vertical scale, offset and position values for

the channels as specified by user prior to start of run.

DDR5 Configuration tab: Measurements settings

Figure 21: Configuration tab settings for DDR5

Table 11: Configuration tab settings for DDR5

Settings Description
Measurements Displays the measurement groups, that are selected in the Test

Selection tab. Select the respective test group to view or modify the
measurement configuration.

Number of UI Enable to execute the selected measurement/s for specified
number of unit intervals.

Table continued…
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Settings Description
Save worst case measurement snapshot Enable to save the worst case measurement snapshot for the

selected measurement.
N start\N stop Specifies the start and stop values for NUI jitter measurements.

where N = 4, 5, 6,….30

BER Specifies the Bit Error Rate.
tCK (ns) Unit interval in seconds.
Superimpose DQS Select to add DQS eye on the data eye diagram.
Stop on Mask Hit Select to stop the test execution as soon as mask hit is observed.
Vertical Scale (Scale to DQ / Scale to DQS) Scales the waveform which is larger among the superimposed eye,

When Superimpose DQS option is checked.

Auto scales to the vertical height of the data signal without
considering the reference clock (DQS) signal amplitude.

Include Margins in the plot Select to display mask margins in the eye diagram plot.
Mask Definition Write Data Eye • Eye Width (UI): It is the Eye Width of stressed eye, based on

the selected Data Rate.
• Eye Height (mV): It is the Eye height of stressed eye based on

the selected Data Rate.

Address Command Eye • TciVW (UI): It is the Rx Timing Window.
• VciVW (V): It is the Rx Mask voltage p-p

Apply DFE When checked, applies the DFE on the Write Data (DQ) and the
output waveform of DQ is used for Write Data Eye measurement.

Gain The gain control of the front end is used to ensure that the cursor or
the current bit is in a congruent relationship with the ISI correction
required for the channel.

Threshold It is the middle voltage level of the signal, which may be the
transition between logic levels. For biased signals, enter the mid-
level value.

Tap (1 to 4) The taps T1, T2, T3, T4 coefficients provide the corrections to the
current bit by adding or subtracting the effects of ISI of the previous
bits.

Table continued…
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Settings Description
Ref Levels Clock / DQS / DQ / CA Timing measurements are based on the state transition times.

Edges occur when a waveform crosses specified reference voltage
levels. Reference voltage levels must be set so that the application
can identify state transitions on a waveform. By default, the
application automatically chooses reference voltage levels when
necessary.
Base top method Specifies the Base-Top method,

used for all reference voltage
levels when auto set occurs.

Absolute Select to manually configure the
reference level settings.

Percentage Select to manually configure
the reference level settings in
percentage.

High Level Sets the high threshold level for
the rising and falling edge of the
source.

Mid Level Sets the middle threshold level
for the rising and falling edge of
the source.

Low Level Sets the low threshold level for
the rising and falling edge of the
source.

Hysteresis Sets the threshold margin to
the reference level, in which
the voltage must cross to be
recognized as changing; the
margin is the relative reference
level plus or minus hysteresis;
use to filter out spurious events.
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LPDDR5-5X Configuration tab: Measurements settings

Figure 22: Configuration tab settings for LPDDR5-5X

Table 12: Configuration tab settings for LPDDR5-5X

Settings Description
Measurements Displays the measurement groups that are selected in the Test

Selection tab. Select the respective test group to view or modify the
measurement configuration.

Window Size Measurement analysis is done on a window of size 200 cycles with
a step increment of 1 cycle. As per the standard, the default window
size is 200. You can set window size up to 1M.

Number of UI (M) Select to execute the selected measurement/s for the specified
number of intervals.

Save worst case measurement snapshot Enable to save the worst-case measurement snapshot for the
selected measurement.

Superimpose WCK\Superimpose RDQS Select to add WCK/RDQS eye on the data eye diagram.
Stop On Mask Hit Select to stop the test execution as soon as mask hit is observed.
Vertical Scale [Scale to DQ / Scale to WCK / Scale to RDQS] Scales the waveform which is larger among the superimposed eye,

When Superimpose WCK / RDQS option is checked.

Auto scales the vertical height of the data signal without considering
the reference clock (WCK / RDQS) signal amplitude.

Include Margins in the plot Select to display mask margins in the eye diagram plot.
Table continued…
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Settings Description
Mask Defnition Write Data Eye • TDIVW1 (UI): It is the DQ Rx mask width.

• TDIVW2 (UI): It is the DQ Rx mask width at VDIVW.
• VDIVW (V): It is the DQ Rx mask height.

Address Command Eye • TCIVW1 (UI): It is CA Rx mask width.
• TCIVW2 (UI): It is the CA Rx mask width at VCIVW.
• VCIVW (V): It is the CA Rx mask height.

Chip Select Eye • TCSIVW1 (UI): It is CS Rx mask width.
• TCSIVW2 (UI): It is the CS Rx mask width at VCSIVW.
• VCSIVW (V): It is the CS Rx mask height.

Ref Levels Clock / WCK / RDQS / DQ / CA /CS Timing measurements are based on the state transition times.
Edges occur when a waveform crosses specified reference voltage
levels. Reference voltage levels must be set so that the application
can identify state transitions on a waveform. By default, the
application automatically chooses reference voltage levels when
necessary.
Base top method Specifies the Base-Top method,

used for all reference voltage
levels when auto set occurs.

Absolute Select to manually configure the
reference level settings.

Percentage Select to manually configure
the reference level settings in
percentage.

High Level Sets the high threshold level for
the rising and falling edge of the
source.

Mid Level Sets the middle threshold level
for the rising and falling edge of
the source.

Low Level Sets the low threshold level for
the rising and falling edge of the
source.

Hysteresis Sets the threshold margin to
the reference level, in which
the voltage must cross to be
recognized as changing; the
margin is the relative reference
level plus or minus hysteresis;
use to filter out spurious events.

Preferences: Set the test run preferences
Use Preferences tab to set the application action on completion of a measurement. The Preferences tab has the feature to enable or
disable certain options related to the measurement execution.
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Figure 23: Preferences tab

Refer the below table for the options available in the Preferences tab:

Table 13: Preferences tab settings
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Status panel: View the test execution status
The Status panel contains the Test Status and Log View tabs, which provides status on the test acquisition and analysis (Test Status) and
listing of test tasks performed (Log View tab). The application opens the Test Status tab when you start to execute the test. Select the
Test Status or the Log View tab to view these items while the test execution is in progress.

View test execution status
The tests are grouped and displayed based on the Clock and Data lane. It displays the tests along with the acquisition type, acquire, and
analysis status of the tests. In pre-recorded mode, Acquire Status is not valid.

The Test Status tab presents a collapsible table with information about each test as it is running. Use the symbols to expand ( ) and
collapse ( ) the table rows.

Figure 24: Test execution status view in DDR5 Status panel

Status panel: View the test execution status
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Figure 25: Test execution status view in LPDDR5-5X Status panel

Table 14: Test execution status table headers

Control Description
Test Name Displays the measurement name.
Acquisition Describes the type of data being acquired.
Acquire Status Displays the progress state of the acquisition:

• To be started

Analysis Status Displays the progress state of the analysis:

• To be started
• Completed

View test execution logs
The Test Status tab displays the detailed execution status of the tests. Also, displays each and every execution step in detail with its
timestamp information. The log details can be used to troubleshoot and resolve any issue/bug which is blocking the test execution process.

Status panel: View the test execution status
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Figure 26: Log view in DDR5 Status panel

Figure 27: Log view in LPDDR5-5X Status panel

Status panel: View the test execution status
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Table 15: Status panel settings

Control Description
Message History Lists all the executed test operations and timestamp information.
Auto Scroll Enables automatic scrolling of the log view as information is added to the log during the test execution.

Clear Log Clears all the messages from the log view.
Save Saves the log file into a text file format. Use the standard Save File window to navigate to and specify

the folder and file name to save the log text.
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Results panel: View summary of test results
When a test execution is complete, the application automatically opens the Results panel to display a summary of test results.

In the Results table, each test result occupies a row. By default, results are displayed in summary format with the measurement details
collapsed and with the Pass/Fail column visible.

Figure 28: DDR5 Results panel with measurement results

Results panel: View summary of test results
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Figure 29: LPDDR5-5X Results panel with measurement results

Click  icon on each measurement in the row to expand and to display the minimum and maximum parameter values of the
measurement.

Filter the test results
Each column in the result table can be customized and displayed by enabling or disabling any column as per your requirement. You can
change the view in the following ways:

• To remove or restore the Pass/Fail column, select Preferences > Show Pass/Fail.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To expand all the listed tests, select View Results Details from the Preferences menu in the upper right corner.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
• To view the results grouped by lane or test, select the corresponding item from the Preferences menu.
• To expand the width of a column, place the cursor over the vertical line that separates the column from the column to the right. When

the cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.
• To clear all test results displayed, click Clear.

Results panel: View summary of test results
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Reports panel: Configure report generation settings
Click Reports panel to configure the report generation settings and select the test result information to include in the report. You can use
the Reports panel to configure report generation settings, select test content to include in reports, generate the report, view the report,
browse for reports, name and save reports, and select report viewing options.

Select report generation options
This section describes the report generation settings you can configure in the Reports panel. Select report settings before running a test or
when creating and saving test setups. Report settings configured are included in saved test setups.

Report configuration tab settings
Table 16: Report View panel settings

Control Description
Report Update Mode Settings
Generate new report Each time when you click Run and when the test execution

is complete, it will create a new report. The report can be in
either .mht, .pdf, or .csv file formats.

Append with previous run session Appends the latest test results to the end of the current test results
report. Each time when you click this option and run the tests, it will
run the previously failed tests and replace the failed test result with
the new pass test result in the same report.

Include header in appended reports Select to include header in appended reports.
Replace current test in previous run session Replaces the previous test results with the latest test results.

Results from newly added tests are appended to the end of the

report.

In previous run, current session Select to replace current test results in the report with the test
result(s) of previous run in the current session.

In any run, any session Select to replace current test results in the report with the test
result(s) in the selected run session’s report. Click and select test
result of any other run session.

Report Creation Settings
Table continued…
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Control Description
Report name Displays the name and path of the <Application Name>

report. The default location is at \My Documents>\My
TekExpress\<Application Name>\Reports. The
report file in this folder gets overwritten each time you run a test
unless you specify a unique name or select to auto increment the
report name.

To change the report name or location, do one of the following:

• In the Report Path field, type the current folder path and name.
• Double-click in the Report Path field and then make selections

from the popup keyboard and click Enter.

Be sure to include the entire folder path, the file name,
and the file extension. For example: C:\Documents
and Settings\your user name\My
Documents\My TekExpress\<Application
Name> \DUT001.mht.

Note: You cannot set the file location using the Browse
button.

Open an existing report click Browse, locate and select the report
file and then click View at the bottom of the panel.

Save as type Saves a report in the specified file type, selected from the dropdown
list. The report is saved in .csv, .pdf, or .mht.

Note: If you select a file type different from the default,
be sure to change the report file name extension in the
Report Name field to match.

Auto increment report name if duplicate Sets the application to automatically increment the name of the
report file if the application finds a file with the same name as the
one being generated. For example: DUT001, DUT002, DUT003.
This option is enabled by default.

Create report automatically at the end of the run Select to create the report with the settings configured, at the end of
run.

View report after generating Automatically opens the report in a Web browser when the test
execution is complete. This option is selected by default.

Table 17: Report View tab settings

Control Description
Contents to Save Settings
Include pass/fail info in details table Select to include pass/fail information in the details table of the

report.
Include detailed results Select to include detailed results in the report.
Include plot images Select to include the plot images in the report.
Table continued…
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Control Description
Include setup configuration Sets the application to include hardware and software information in

the summary box at the top of the report. Information includes: the
oscilloscope model and serial number, the oscilloscope firmware
version, and software versions for applications used in the
measurements.

Include complete application configuration Select to include the complete application configuration in the
report.

Include user comments Select to include any comments about the test that you or another
user have added in the DUT tab of the Setup panel. Comments
appear in the Comments section, below the summary box at the
beginning of each report.

Include statics table Select to include test run statistics in the report. This is enabled
when you run any test for more than once. Set Acquire/Analyze
each test in the Preferences tab to more than one, to run any test
for multiple times.

Include Informative Results Select to include results for informative tests.
Group Report By Settings
Test Name Select to group the test results based on the test name in the report.
Test Result Select to group the test results based on the test result in the report.
Lane Name Select to group the test results based on the Lanes in the report.
Data Rate Select to group the test results based on the Data Rate in the

report.
Images Select to group the test results based on the images in the report.
Report Type Settings
Compliance Select to include compliance results only.
All Results Select to include all results.

Table 18: Other Report Panel settings

Control Description
View Click to view the most current report.
Generate Report Generates a new report based on the current analysis results.
Save As Specify a name for the report.

Reports panel: Configure report generation settings

TekExpress® DDR Tx Software Printable Application Help 51



View a generated report
Sample report and its contents
A report shows detailed results and plots, as set in the Reports panel.

Figure 30: Report for DDR5

Figure 31: Report for LPDDR5-5X

Setup Information The summary box at the beginning of the report lists setup configuration information. This information
includes the oscilloscope model and serial number, optical module model and serial number, and software
version numbers of all associated applications.

User comments If you had selected to include comments in the test report, any comments you added in the DUT tab are
shown at the top of the report.

Test Name Summary Table The test summary table lists all the tests which are executed with its result status.

Reports panel: Configure report generation settings
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Measurement The measurement table displays the measurement related details with its parameter value.
Plot Any Plot associated to the measurements excuted.
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Saving and recalling test setup

Test setup files overview
Saved test setup information (such as the selected oscilloscope, general parameters, acquisition parameters, measurement limits,
waveforms (if applicable), and other configuration settings) are saved under the setup name at X:\<Application Name>.

Use test setups to:

• Run a new session, acquire live waveforms, using a saved test configuration.
• Create a new test setup using an existing one.
• View all the information associated with a saved test, including the log file, the history of the test status as it executed, and the results

summary.
• Run a saved test using saved waveforms.

Save the configured test setup
You can save a test setup before or after running a test. You can create a test setup from already created test setup or using a default
test setup. When you save a setup, all the parameters, measurement limits, waveform files (if applicable), test selections, and other
configuration settings are saved under the setup name. When you select the default test setup, the parameters are set to the application’s
default value.

Select Options > Save Test Setup to save the opened setup.

Select Options > Save Test Setup As to save the setup with different name.

Load a saved test setup
To open (load) a saved test setup, do the following:

• Select Options > Open Test Setup.
• Select the setup from the list and click Open. Setup files are located at X:\<Application Name>.

Select a pre-run session from the loaded test setup
Complete the following steps to load a test setup from a pre-run session:

1. Select Options > Open Test Setup.
2. Select a setup from the list and then click Open. Setup files are located at X:\<Application Name>\.
3. Switch the mode to Pre-recorded waveform files in the DUT panel.
4. Select the required waveforms from the selected setup in the Acquisition tab and Run the required test.

Saving and recalling test setup

54



Save the test setup with a different name
To create a test setup with a different name, follow the steps:

1. Select Options > Open Test Setup.
2. Select a setup from the list and then click Open.
3. Click application setup and modify the parameters.
4. Click application reports and modify the report options.
5. Select Options > Save Test Setup As.
6. Enter the test setup name and click Save.
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SCPI Commands

About SCPI command
You can use the Standard Commands for Programmable Instruments (SCPI) to communicate remotely with the TekExpress application.
Complete the TCPIP socket configuration and the TekVISA configuration in the oscilloscope or in the device where you are executing the
script.

Note: If you are using an external PC to execute the remote interface commands, then install TekVISA in the PC to make the
configurations.

Socket configuration for SCPI commands
This section describes the steps to configure the TCPIP socket configuration in your script execution device and the steps to configure the
TekVISA configuration in the oscilloscope to execute the SCPI commands.

TCPIP socket configuration
1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule…
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3. In New Inbound Rule Wizard menu

a. Select Port and click Next.

b. Select TCP as rule apply, enter 5000 for Specific local ports and click Next.
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c. Select Allow the connection and click Next.

d. Select Domain, Private, Public checkbox and click Next.
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e. Enter Name, Description (optional), and click Finish.

4. Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.

SCPI Commands
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TekVISA configuration
1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Select Socket from the drop-down list, enter the IP address of

the TekExpress device in Hostname and type Port as 5000. Click  to configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
oscilloscope where the TekExpress application is running.
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3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.

4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.
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Set or query the device name of application
This command sets or queries the device name of the application.

Syntax
TEKEXP:SELECT DEVICE,"<DeviceName>" (Set)

TEKEXP:SELECT? DEVICE (Query)

Command arguments
Argument Name Argument Type
<DeviceName> <String>

Returns
<String>

Examples
TEKEXP:SELECT DEVICE,"<DUT001>" command sets the device name of the application to DUT001.

TEKEXP:SELECT? DEVICE command returns the selected device name of the application.

Set or query the test name of the application
This command selects or deselects the specified test name of the application.

Syntax
TEKEXP:SELECT TEST,"<TestName>",<Value> (Set)

TEKEXP:SELECT TEST,"<ALL>" (Set)
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TEKEXP:SELECT? TEST (Query)

Command arguments
Table 19: For DDR5

<TestName> <Value>

• Clock Group measurements

• tCK
• tCK_Duty_UI_Error
• tCK_1UI_RJ_NoBUJ
• tCK_1UI_DJ_NoBUJ
• tCK_1UI_TJ_NoBUJ
• tCK_2UI_RJ_NoBUJ
• tCK_2UI_DJ_NoBUJ
• tCK_2UI_TJ_NoBUJ
• tCK_3UI_RJ_NoBUJ
• tCK_3UI_DJ_NoBUJ
• tCK_3UI_TJ_NoBUJ
• tCK_NUI_RJ_NoBUJ
• tCK_NUI_DJ_NoBUJ
• tCK_NUI_TJ_NoBUJ
• VIHdiff.CK(AC)
• VIHdiff.CK(DC)
• VILdiff.CK(AC)
• VILdiff.CK(DC)
• SRIdiff-Rise
• SRIdiff-Fall
• VIX_CK_Ratio

• Write Burst measurements

• RxMask
• Eye-Height_Write
• Eye-Width_Write
• Eye-Jitter_Write
• VcentDq
• tWPRE
• tWPST
• tDQS2DQ
• tDQSS
• tDSS
• tDSH
• InputSlew-Diff-Rise(DQS)
• InputSlew-Diff-Fall(DQS)

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected
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<TestName> <Value>

• VIX_DQS_Ratio

• Read Burst measurements

• Eye-Height_Read
• Eye-Width_Read
• Eye-Jitter_Read
• tRPRE
• tRPST
• tDQSCK
• VOHdiffAC
• VOLdiffAC
• VOH(AC)
• VOH(DC)
• VOL(AC)
• VOL(DC)
• SRQdiff-Rise(DQS)
• SRQdiff-Fall(DQS)
• SRQse-Rise(DQ)
• SRQse-Fall(DQ)

• CA measurements

• RxMask_CA
• VciVW
• TciVW
• VcentCa
• VIHL_AC
• TcIPW
• SRIN_cIVW_Rise
• SRIN_cIVW_Fall

Table 20: For LPDDR5-5X

<TestName> <Value>

• Clock Measurements

• tCH(abs)
• tCH(avg)
• tCK(abs)
• tCK(avg)
• tCL(abs)
• tCL(avg)
• tJIT(cc)

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected
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<TestName> <Value>

• tJIT(per)
• VIHdiff_CK
• VILdiff_CK
• Vindiff_CK
• Vindiff_High_CK
• Vindiff_Low_CK
• SRIdiff_Rise_CK
• SRIdiff_Fall_CK
• VIX_CK_Ratio
• Overshoot_Amplitude_CK_t
• Overshoot_Area_CK_t
• Overshoot_Amplitude_CK_c
• Overshoot_Area_CK_c
• Undershoot_Amplitude_CK_t
• Undershoot_Area_CK_t
• Undershoot_Amplitude_CK_c
• Undershoot_Area_CK_c
• Vinse_CK_t
• Vinse_High_CK_t
• Vinse_Low_CK_t
• Vinse_CK_c
• Vinse_High_CK_c
• Vinse_Low_CK_c

• Write Clock Measurements

• tWCKH(abs)
• tWCKH(avg)
• tWCK(abs)
• tWCK(avg)
• tWCKL(abs)
• tWCKL(avg)
• tJIT(cc)_WCK
• tJIT(per)_WCK
• tERR(2per)
• tERR(3per)
• tERR(4per)

• Read Burst Measurements

• tRPRE
• tRPST
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<TestName> <Value>

• tQH
• tDQSQ
• tQW
• tQSH
• tQSL
• SRQdiff_Rise_RDQS
• SRQdiff_Fall_RDQS
• SRQse_Rise_DQ
• SRQse_Fall_DQ
• Overshoot_Amplitude_RDQS_t
• Overshoot_Area_RDQS_t
• Undershoot_Amplitude_RDQS_t
• Undershoot_Area_RDQS_t
• Overshoot_Amplitude_RDQS_c
• Overshoot_Area_RDQS_c
• Undershoot_Amplitude_RDQS_c
• Undershoot_Area_RDQS_c
• Overshoot_Amplitude_RD_DQ
• Overshoot_Area_RD_DQ
• Undershoot_Amplitude_RD_DQ
• Undershoot_Area_RD_DQ

• Write Burst Measurements

• RxMask_Write
• tDIVW1
• tDIVW2
• vDIVW
• VcentDQ
• tDIPW
• tDIPW1
• tDIPW2
• tDIHL_Above
• tDIHL_Below
• vDIHL_AC
• vDIHP1
• vDILP1
• vDIHP2
• vDILP2
• tWCK2DQI
• tWCK2CK
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<TestName> <Value>

• VIHdiff_WCK
• VILdiff_WCK
• Vindiff_WCK
• Vindiff_High_WCK
• Vindiff_Low_WCK
• SRIdiff_Rise_WCK
• SRIdiff_Fall_WCK
• tDQ2DQ
• VIX_WCK_Ratio
• Overshoot_Amplitude_WCK_t
• Overshoot_Area_WCK_t
• Undershoot_Amplitude_WCK_t
• Undershoot_Area_WCK_t
• Overshoot_Amplitude_WCK_c
• Overshoot_Area_WCK_c
• Undershoot_Amplitude_WCK_c
• Undershoot_Area_WCK_c
• Overshoot_Amplitude_WR_DQ
• Overshoot_Area_WR_DQ
• Undershoot_Amplitude_WR_DQ
• Undershoot_Area_WR_DQ
• Vinse_WCK_t
• Vinse_High_WCK_t
• Vinse_Low_WCK_t
• Vinse_WCK_c
• Vinse_High_WCK_c
• Vinse_Low_WCK_c

• CA Measurements

• RXMask_CA
• tCIVW1
• tCIVW2
• vCIVW
• VcentCA
• tCIPW_Positive
• tCIPW_Negative
• vCIHL_AC
• Overshoot_Amplitude_CA
• Overshoot_Area_CA
• Undershoot_Amplitude_CA
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<TestName> <Value>

• Undershoot_Area_CA
• tCA2CA

• CS Measurements

• RXMask_CS
• tCSIVW1
• tCSIVW2
• vCSIVW
• VcentCS
• tCSIPW_Positive
• tCSIPW_Negative
• vCSIHL_AC
• Overshoot_Amplitude_CS
• Overshoot_Area_CS
• Undershoot_Amplitude_CS
• Undershoot_Area_CS

Returns
{True | False} or {1 | 0}

Examples
TEKEXP:SELECT TEST,"<TestName>",1 command selects the specified test in the Test Panel.

TEKEXP:SELECT TEST,"<ALL>" command select all the tests in the Test Panel.

TEKEXP:SELECT? TEST command returns the list of selected tests.

Set or query the general parameter values
This command sets or queries the general parameter values of the application.

Syntax
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" (Set)

TEKEXP:VALUE? GENERAL,"<ParameterName>" (Query)

Command arguments

Table 21: Report panel command parameters

<ParameterName> <Value>
Report Update Mode • New

• Append
• Replace

Table continued…
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<ParameterName> <Value>
Report Path X:\<application name>\Reports\DUT001.mht

Save As Type • Web Archive (*.mht;*.mhtml)
• PDF (*.pdf;)
• CSV (*.csv;)

Auto increment report name if duplicate {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Create report at the end {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Pass/Fail Results Summary {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Detailed Results {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Plot Images {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Setup Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table continued…
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<ParameterName> <Value>
Include Complete Application Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include User Comments {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table 22: General command parameters for DDR5

ParameterName Value

DataRate Specifies the different data rates supported (3200>=DR<=8400).

Valid values are:

• 3200
• 3600
• 4000
• 4400
• 4800
• 5200
• 5600
• 6000
• 6400
• 6800
• 7200
• 7600
• 8000
• 8400
• Custom

Custom DataRate 1600 to 15000

Vdd • JEDEC Default
• Manual

Table continued…
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ParameterName Value

Vdd Display Displays the Vdd value in Volts. To set the Vdd a valid Double value can be specified.

Note: Set Vdd to Manual Mode before setting its value.

-6 to 6

Vcent_DQ • Auto_Vcent
• Manual_Vcent

Vcent_DQ Display Specifies the Vcent_DQ value in Volts. To set the Vcent_DQ a valid Double value can be
specified.

Note: Set Vcent_DQ to Manual Mode before setting its value.

0 to 2

Vcent_CA • Auto_Vcent_CA
• Manual_Vcent_CA

Vcent_CA Display Specifies the Vcent-CA value in Volts. To set the Vcent-CA a valid Double value can be specified.

Note: Set Vcent-CA to Manual Mode before setting its value.

0 to 2

Burst Detection Method • Read Write Bursts
• Write Only Bursts
• Read Only Bursts
• Visual Search

Clock Signal Probe Type • Differential
• Single Ended

DQS Signal Probe Type • Differential
• Single Ended

DQS Probe Mode • A
• B
• Differential

Clock Probe Mode • A
• B
• Differential

Table continued…
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ParameterName Value

DQSPositive Probe Mode • A
• B
• Differential

DQSNegative Probe Mode • A
• B
• Differential

DQ Probe Mode • A
• B
• Differential

ADDR CMD Probe Mode • A
• B
• Differential

Clock(+) Probe Mode • A
• B
• Differential

Clock(-) Probe Mode • A
• B
• Differential

DeEmbed Filter Files • Enable
• Disable

DQS_Read Connected to Filter File Mention the path for filter file for DQS Read signal

DQS_Write Connected to Filter File Mention the path for filter file for DQS Write signal

Clock Connected to Filter File Mention the path for filter file for Clock signal

DQS(+)_Write Connected to Filter File Mention the path for filter file for Strobe Positive for Data signal

DQS(-)_Write Connected to Filter File Mention the path for filter file for Strobe Negative for Data signal

DQ_Read Connected to Filter File Mention the filter file path for Data Read Signal

DQ_Write Connected to Filter File Mention the filter file path for Data Write Signal

CA Connected to Filter File Mention the filter file path for Command and Address Signal

Clock(+) Connected to Filter File Mention the filter file path for Clock Positive Signal

Clock(-) Connected to Filter File Mention the filter file path for Clock Positive Signal

Table continued…
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ParameterName Value

Sample Rate (GS/s) 50

Record Length (mpts) 0.001 to 100

Run Test More than Once • False
• True

Number of Runs 2 to 1000

Retain Vertical Scale • False
• True

RB:DQ/DQS Phase Alignment:Burst
Detection Level Type

• Auto
• Manual

RB:DQ/DQS Phase Alignment:Pre-
amble Length (tCK)

• 1
• 2
• 3
• 4

RB:DQ/DQS Phase Alignment:Post-
amble Length (tCK)

• 0.5
• 1.5

RB:DQ/DQS Phase Alignment:Burst
Length

• 16
• 32

RB:DQ/DQS Phase
Alignment:Burst(pk-pk)

0 to 5

RB:DQ/DQS Phase
Alignment:Margin(%)

0 to 100

RB:DQ/DQS Phase
Alignment:BurstDetectionMode

• Auto
• Manual

RB:DQ/DQS Phase
Alignment:IsReadWriteGreater

• Yes
• No

RB:DQ/DQS Phase Alignment:Strobe
High

-5 to 5

RB:DQ/DQS Phase Alignment:Strobe
Mid

-5 to 5

RB:DQ/DQS Phase Alignment:Strobe
Low

-5 to 5

Table continued…
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ParameterName Value

RB:DQ/DQS Phase Alignment:Data
High

-5 to 5

RB:DQ/DQS Phase Alignment:Data
Mid

-5 to 5

RB:DQ/DQS Phase Alignment:Data
Low

-5 to 5

RB:DQ/DQS Phase
Alignment:Hysteresis

0 to 50

RB:DQ/DQS Phase Alignment:Margin 0 to 100

WB:DQ/DQS Phase
Alignment:tDQS2DQ Type

• Auto
• Manual

WB:DQ/DQS Phase
Alignment:tDQS2DQ Value (ps)

0 to 1875 ps

WB:DQ/DQS Phase Alignment:Burst
Detection Level Type

• Auto
• Manual

WB:DQ/DQS Phase Alignment:Pre-
amble Length (tCK)

• 2
• 3
• 4

WB:DQ/DQS Phase Alignment:Post-
amble Length (tCK)

• 0.5
• 1.5

WB:DQ/DQS Phase Alignment:Burst
Length

• 16
• 32

WB:DQ/DQS Phase
Alignment:Burst(pk-pk)

0 to 50

WB:DQ/DQS Phase
Alignment:Margin(%)

0 to 100

WB:DQ/DQS Phase
Alignment:BurstDetectionMode

• Auto
• Manual

WB:DQ/DQS Phase
Alignment:IsReadWriteGreater

• Yes
• No

WB:DQ/DQS Phase Alignment:Strobe
High

-5 to 5

Table continued…
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ParameterName Value

WB:DQ/DQS Phase Alignment:Strobe
Mid

-5 to 5

WB:DQ/DQS Phase Alignment:Strobe
Low

-5 to 5

WB:DQ/DQS Phase Alignment:Data
High

-5 to 5

WB:DQ/DQS Phase Alignment:Data
Mid

-5 to 5

WB:DQ/DQS Phase Alignment:Data
Low

-5 to 5

WB:DQ/DQS Phase
Alignment:Hysteresis

0 to 50

WB:DQ/DQS Phase Alignment:Margin 0 to 100

Read Burst:Burst Detection Level
Type

• Auto
• Manual

Read Burst:Pre-amble Length (tCK) • 1
• 2
• 3
• 4

Read Burst:Post-amble Length (tCK) • 0.5
• 1.5

Read Burst:Burst Length • 16
• 32

Read Burst:Strobe High -1.1 to 1.1

Read Burst:Strobe Mid -1.1 to 1.1

Read Burst:Strobe Low -1.1 to 1.1

Read Burst:Data High -1.1 to 1.1

Read Burst:Data Mid -1.1 to 1.1

Read Burst:Data Low -1.1 to 1.1

Read Burst:Hysteresis 0 to 20

Table continued…
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ParameterName Value

Read Burst:Margin 0 to 100

Write Burst:Burst Detection Level
Type

• Auto
• Manual

Write Burst:Pre-amble Length (tCK) • 2
• 3
• 4

Write Burst:Post-amble Length (tCK) • 0.5
• 1.5

Write Burst:Burst Length • 16
• 32

Write Burst:tDQS2DQ Type • Auto
• Manual

Write Burst:tDQS2DQ Value (ps) 0 to 1875 ps

Write Burst:Strobe High -1.1 to 1.1

Write Burst:Strobe Mid -1.1 to 1.1

Write Burst:Strobe Low -1.1 to 1.1

Write Burst:Data High -1.1 to 1.1

Write Burst:Data Mid -1.1 to 1.1

Write Burst:Data Low -1.1 to 1.1

Write Burst:Hysteresis 0 to 20

Write Burst:Margin 0 to 100

Visual Search Burst Detection Area • Define visual trigger area on the screen
• Visual trigger setup file path for visual search

VT Setup File Mention the path of VT setup File

Clock Signal Probe Type • Single Ended
• Differential

DQS Signal Probe Type • Single Ended
• Differential

Table continued…
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ParameterName Value

DQ Connected to : Signal Selected • True
• False

DQ Connected to • CH1
• CH2
• CH3
• CH4

DQS Connected to : Signal Selected • True
• False

DQS Connected to • CH1
• CH2
• CH3
• CH4

CA Connected to : Signal Selected • True
• False

CA Connected to • CH1
• CH2
• CH3
• CH4

Clock Connected to : Signal Selected • True
• False

Clock Connected to • CH1
• CH2
• CH3
• CH4

Clock(+) Connected to : Signal
Selected

• True
• False

Clock(+) Connected to • CH1
• CH2
• CH3
• CH4

Clock(-) Connected to : Signal
Selected

• True
• False

Table continued…
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ParameterName Value

Clock(-) Connected to • CH1
• CH2
• CH3
• CH4

DQS(+) Connected to : Signal
Selected

• True
• False

DQS(-) Connected to : Signal
Selected

• True
• False

DQS(+) Connected to • CH1
• CH2
• CH3
• CH4

DQS(-) Connected to • CH1
• CH2
• CH3
• CH4

Bandwidth 8 to 70

On Failure Stop and Notify • True
• False

Timer Warning Info Message Popup • True
• False

Timer Warning Info Message Popup
Duration

• -2
• 2

Timer Error Message Popup • True
• False

Timer Error Message Popup Duration • -2
• 2

Enable Logging • True
• False
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Table 23: General command parameters for LPDDR5-5X

ParameterName Value
DataRate When WCK:CK=4:1

• 40
• 533
• 1067
• 1600
• 2133
• 2750
• 3200
• 3733
• 4267
• 4800
• 5500
• 6000
• 6400
• 7500
• 8533
• Custom

When WCK:CK=2:1

• 40
• 533
• 1067
• 1600
• 2133
• 2750
• 3200
• Custom

Custom DataRate 40 to 15000

WCK:CK Ratio • 2:1
• 4:1

Clock Frequency • 5
• 3750

WCK Frequency • 20
• 7500

Table continued…
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ParameterName Value
Burst Detection Method • Read Write Bursts

• Write Only Bursts
• Read Only Bursts
• Visual Search

Clock Signal Probe Type • Differential
• Single Ended
• Single Ended (+)

WCK RDQS Signal Probe Type • Differential
• Single Ended
• Single Ended (+)
• Single Ended (-)

Visual Search Burst Detection Area • Define visual trigger area on the screen
• Visual trigger setup file path for visual search

VT Setup File Mention the path of VT setup File
Vdd2 • JEDEC Default

• Manual

Vdd2 Display -6 to 6
VDDQ Value 0 to 5 V
VOH Value • VDDQ

• VDDQ/2

Vcent_DQ • Auto_Vcent
• Manual_Vcent

Vcent_DQ Display 0 to 2
Vcent_CA • Auto_Vcent_CA

• Manual_Vcent_CA

Vcent_CA Display 0 to 2
Vcent_CS • Auto_Vcent_CS

• Manual_Vcent_CS

Vcent_CS Display 0 to 2
WCK Probe Mode • A

• B
• Differential

Table continued…
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ParameterName Value
RDQS Probe Mode • A

• B
• Differential

Clock Probe Mode • A
• B
• Differential

DQ Probe Mode • A
• B
• Differential

DQy Probe Mode • A
• B
• Differential

WCK(+) Probe Mode • A
• B
• Differential

WCK(-) Probe Mode • A
• B
• Differential

RDQS(+) Probe Mode • A
• B
• Differential

RDQS(-) Probe Mode • A
• B
• Differential

Clock(+) Probe Mode • A
• B
• Differential

Clock(-) Probe Mode • A
• B
• Differential

DQy Connected to : Signal Selected • True
• False

Table continued…
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ParameterName Value
DQ Connected to : Signal Selected • True

• False

RDQS Connected to : Signal Selected • True
• False

RDQS(+) Connected to : Signal Selected • True
• False

RDQS(-) Connected to : Signal Selected • True
• False

Clock Connected to : Signal Selected • True
• False

Clock(+) Connected to : Signal Selected • True
• False

Clock(-) Connected to : Signal Selected • True
• False

CA#a Connected to : Signal Selected • True
• False

WCK Connected to : Signal Selected • True
• False

WCK(+) Connected to : Signal Selected • True
• False

WCK(-) Connected to : Signal Selected • True
• False

CA#b Connected to : Signal Selected • True
• False

CS Connected to : Signal Selected • True
• False

CA#a Probe Mode • A
• B
• Differential

Table continued…
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ParameterName Value
CA#b Probe Mode • A

• B
• Differential

CS Probe Mode • A
• B
• Differential

DeEmbed Filter Files • Enable
• Disable

RB:DQ/DQS Phase Alignment:Burst Detection Level Type • Auto
• Manual

RB:DQ/DQS Phase Alignment:tDQSQ • Auto
• Manual

RB:DQ/DQS Phase Alignment:tDQSQ Value 0 to 65000
RB:DQ/DQS Phase Alignment:Pre-amble Static (tWCK) • 0

• 2
• 4
• tRDS_PRE

RB:DQ/DQS Phase Alignment:PreAmble Static Value • 2
• 4

(Applicable when Pre-amble Static=tRDS_PRE)

RB:DQ/DQS Phase Alignment:Pre-amble Toggle (tWCK) 0 to 4
RB:DQ/DQS Phase Alignment:Post-amble Length (tCK) • 0.5

• 2.5
• 4.5

RB:DQ/DQS Phase Alignment:Postamble Mode • Static
• Toggle

RB:DQ/DQS Phase Alignment:Burst Length • 16
• 32

RB:DQ/DQS Phase Alignment:Strobe High -5 to 5
RB:DQ/DQS Phase Alignment:Strobe Mid -5 to 5
RB:DQ/DQS Phase Alignment:Strobe Low -5 to 5
RB:DQ/DQS Phase Alignment:Data High -5 to 5
RB:DQ/DQS Phase Alignment:Data Mid -5 to 5
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ParameterName Value
RB:DQ/DQS Phase Alignment:Data Low -5 to 5
RB:DQ/DQS Phase Alignment:Hysteresis 0 to 50
RB:DQ/DQS Phase Alignment:Margin 0 to 100
WB:DQ/DQS Phase Alignment:tWCK2DQI Type • Auto

• Manual

WB:DQ/DQS Phase Alignment:tWCK2DQI Value (ps) 0 to 1875
WB:DQ/DQS Phase Alignment:Burst Detection Level Type • Auto

• Manual

WB:DQ/DQS Phase Alignment:Pre-amble Static (tCK) 1 to 6
WB:DQ/DQS Phase Alignment:Pre-amble Toggle (tCK) 1 to 4
WB:DQ/DQS Phase Alignment:Post-amble Length (tCK) • 2.5

• 4.5
• 6.5

WB:DQ/DQS Phase Alignment:Burst Length • 16
• 32

WB:DQ/DQS Phase Alignment:BurstDetectionMode • Auto
• Manual

WB:DQ/DQS Phase Alignment:Strobe High -5 to 5
WB:DQ/DQS Phase Alignment:Strobe Mid -5 to 5
WB:DQ/DQS Phase Alignment:Strobe Low -5 to 5
WB:DQ/DQS Phase Alignment:Data High -5 to 5
WB:DQ/DQS Phase Alignment:Data Mid -5 to 5
WB:DQ/DQS Phase Alignment:Data Low -5 to 5
WB:DQ/DQS Phase Alignment:Hysteresis 0 to 50
WB:DQ/DQS Phase Alignment:Margin 0 to 100
Read Burst:Burst Detection Level Type • Auto

• Manual

Read Burst:tDQSQ • Auto
• Manual

Read Burst:tDQSQ Value 0 to 65000
Read Burst:Pre-amble Static (tWCK) • 0

• 2
• 4
• tRDS_PRE
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ParameterName Value
Read Burst:PreAmble Static Value 2 to 4 (Applicable when Pre-amble Static=tRDS_PRE)
Read Burst:Pre-amble Toggle (tWCK) 0 to 4
Read Burst:Post-amble Length (tCK) • 0.5

• 2.5
• 4.5

Read Burst:Postamble Mode • Static
• Toggle

Read Burst:Burst Length • 16
• 32

Read Burst:Strobe High -1.1 to 1.1
Read Burst:Strobe Mid -1.1 to 1.1
Read Burst:Strobe Low -1.1 to 1.1
Read Burst:Data High -1.1 to 1.1
Read Burst:Data Mid -1.1 to 1.1
Read Burst:Data Low -1.1 to 1.1
Read Burst:Hysteresis 0 to 20
Read Burst:Margin 0 to 100
Write Burst:Burst Detection Level Type • Auto

• Manual

Write Burst:Pre-amble Static (tCK) 1 to 6
Write Burst:Pre-amble Toggle (tCK) 1 to 4
Write Burst:Post-amble Length (tCK) • 2.5

• 4.5
• 6.5

Write Burst:Burst Length • 16
• 32

Write Burst:tWCK2DQI Type • Auto
• Manual

Write Burst:tWCK2DQI Value (ps) 0 to 1875
Write Burst:Strobe High -1.1 to 1.1
Write Burst:Strobe Mid -1.1 to 1.1
Write Burst:Strobe Low -1.1 to 1.1
Write Burst:Data High -1.1 to 1.1
Write Burst:Data Mid -1.1 to 1.1
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ParameterName Value
Write Burst:Data Low -1.1 to 1.1
Write Burst:Hysteresis 0 to 20
Write Burst:Margin 0 to 100
Record Length (mpts) 0.001 to 100
Sample Rate (GS/s) 50
Bandwidth 8 to 70
Number of Runs 2 to 1000
Run Test More than Once • True

• False

Enable Logging • True
• False

Single-ended mode • True
• False

Retain Vertical Scale • True
• False

Clock Connected to : Signal Selected • True
• False

Clock Connected to • CH1
• CH2
• CH3
• CH4

Clock(+) Connected to : Signal Selected • True
• False

Clock(+) Connected to • CH1
• CH2
• CH3
• CH4

Clock(-) Connected to : Signal Selected • True
• False

Clock(-) Connected to • CH1
• CH2
• CH3
• CH4
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ParameterName Value
WCK(+) Connected to : Signal Selected • True

• False

WCK(+) Connected to • CH1
• CH2
• CH3
• CH4

WCK(-) Connected to : Signal Selected • True
• False

WCK(-) Connected to • CH1
• CH2
• CH3
• CH4

RDQS(+) Connected to : Signal Selected • True
• False

RDQS(+) Connected to • CH1
• CH2
• CH3
• CH4

RDQS(-) Connected to : Signal Selected • True
• False

RDQS(-) Connected to • CH1
• CH2
• CH3
• CH4

CA#a Connected to : Signal Selected • True
• False

CA#a Connected to • CH1
• CH2
• CH3
• CH4

CA#b Connected to : Signal Selected • True
• False

Table continued…
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ParameterName Value
CA#b Connected to • CH1

• CH2
• CH3
• CH4

CS Connected to : Signal Selected • True
• False

CS Connected to • CH1
• CH2
• CH3
• CH4

RDQS Connected to : Signal Selected • True
• False

RDQS Connected to • CH1
• CH2
• CH3
• CH4

DQ Connected to : Signal Selected • True
• False

DQ Connected to • CH1
• CH2
• CH3
• CH4

DQy Connected to : Signal Selected • True
• False

DQy Connected to • CH1
• CH2
• CH3
• CH4

WCK Connected to : Signal Selected • True
• False

WCK Connected to • CH1
• CH2
• CH3
• CH4
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ParameterName Value
RDQS Connected to Filter File Mention the path for filter file for RDQS signal
RDQS(+) Connected to Filter File Mention the path for filter file for RDQS Positive signal
RDQS(-) Connected to Filter File Mention the path for filter file for RDQS Negative signal
WCK Connected to Filter File Mention the path for filter file for WCK signal
WCK(+) Connected to Filter File Mention the path for filter file for WCK Positive signal
WCK(-) Connected to Filter File Mention the path for filter file for WCK Negative signal
Clock Connected to Filter File Mention the path for filter file for Clock signal
DQ_Read Connected to Filter File Metion the path for filter file for Data Read signal
DQ_Write Connected to Filter File Mention the filter file path for Data Write Signal
DQy_Write Connected to Filter File Metion the filter file path for Data Write signal
CA#a Connected to Filter File Mention the path for filter file for Command and Address signal #a

signal
CA#b Connected to Filter File Mention the path for filter file for Command and Address signal #b

signal
CS Connected to Filter File Mention the path for filter file for CS signal
Clock(+) Connected to Filter File Mention the filter file path for Clock Positive Signal
Clock(-) Connected to Filter File Mention the filter file path for Clock Negative Signal

Returns
<NRf> or <String>

Examples
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" command set the value for the specified general
parameter.

TEKEXP:VALUE? GENERAL,"<ParameterName>" command returns the value for the specified general parameter.

Set or query the analyze parameter values
This command sets or queries the analyze parameter values of the application.

Syntax
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" (Query)

Command arguments
Table 24: For DDR5

TestName ParameterName ParameterValue
Clock Target BER 3 to 22

N value Start 4 to 30
N value Stop 4 to 30

Table continued…
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TestName ParameterName ParameterValue
Number of UI state • True

• False

Number of UI value 0.001 to 5000
Worst Case Logging • True

• False

Clock SSC On • True
• False

Scope Rn Rms 0 to 50
Noise Compensation Mode • Auto

• Manual

Reference ID Enter the value manually of
Reference ID.

Ref levels Clock • Absolute
• Percentage

High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10
Slew Rate ref level • Auto

• Manual

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
Ref Levels Autoset Basetop Method Clock • MINMAX

• AUTO

Ref Levels Autoset Basetop Method Clock Single Ended • MINMAX
• AUTO

Ref levels Clock Single Ended • Absolute
• Percentage

High level Percentage Clock Single Ended 1 to 99
Mid level Percentage Clock Single Ended
Low level Percentage Clock Single Ended
Hysteresis Percentage Clock Single Ended 0 to 50
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TestName ParameterName ParameterValue
High level Absolute Clock Single Ended -10 to 10
Mid level Absolute Clock Single Ended
Low level Absolute Clock Single Ended
Hysteresis Absolute Clock Single Ended 0 to 10
Slew Rate ref level Single Ended • Auto

• Manual

Address_Command tCK Value CA 0.1 to 10
Include Margin In Plot • True

• False

tcivw Value 0 to 2
vcivw Value 0 to 10
CA Reference Level Ref levels CA • Absolute

• Percentage

High level Percentage CA 1 to 99
Mid level Percentage CA
Low level Percentage CA
Hysteresis Percentage CA 0 to 50
High level Absolute CA -10 to 10
Mid level Absolute CA
Low level Absolute CA
Hysteresis Absolute CA 0 to 10
Ref Levels Autoset Basetop
Method CA

• MINMAX
• AUTO

Slew_Rate_ref_level_CA • Auto
• Manual

Clock Reference Level Ref levels Clock • Absolute
• Percentage

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10
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TestName ParameterName ParameterValue
Ref Levels Autoset Basetop
Method Clock

• MINMAX
• AUTO

WR_Data_Differential tCK Value 0.1 to 10
Include Margin In Plot • True

• False

Stop On Mask Hit • True
• False

Number of UI state • True
• False

Number of UI value 0.001 to 10000
Worst Case Logging • True

• False

Eye Width(UI) 0 to 2
Eye Height(mV) 0 to 1000
Superimpose DQS • True

• False

Vertical Scale • Scale to DQ
• Scale to DQS

DQS Reference Level Ref Levels Autoset Basetop
Method DQS

• AUTO
• MINMAX

Ref levels DQS • Absolute
• Percentage

High level Percentage DQS 1 to 99
Mid level Percentage DQS
Low level Percentage DQS
Hysteresis Percentage DQS 0 to 50
High level Absolute DQS -10 to 10
Mid level Absolute DQS
Low level Absolute DQS
Hysteresis Absolute DQS 0 to 50
Slew Rate ref level DQS • Auto

• Manual
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TestName ParameterName ParameterValue
Clock Reference Level Ref levels Clock • Absolute

• Percentage

Ref Levels Autoset Basetop
Method Clock

• AUTO
• MINMAX

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10

DQ Reference Level Ref Levels Autoset Basetop
Method DQ

• AUTO
• MINMAX

Ref levels DQ • Absolute
• Percentage

High level Percentage DQ 1 to 99
Mid level Percentage DQ
Low level Percentage DQ
Hysteresis Percentage DQ 0 to 50
High level Absolute DQ -10 to 10
Mid level Absolute DQ
Low level Absolute DQ
Hysteresis Absolute DQ 0 to 10

GAIN -6 to 6
TAP1 -200 to 50
TAP2 -75 to 75
TAP3 -60 to 60
TAP4 -45 to 45
Apply DFE • True

• False

ThresholdLevel • Auto
• Manual

Threshold 0 to 2000
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TestName ParameterName ParameterValue
WR_Data_SingleEnded Number of UI state • True

• False

Number of UI value 0.001 to 2000
Worst Case Logging • True

• False

DQS Reference Level Ref Levels Autoset Basetop
Method DQS

• AUTO
• MINMAX

Ref levels DQS • Absolute
• Percentage

High level Percentage DQS 1 to 99
Mid level Percentage DQS
Low level Percentage DQS
Hysteresis Percentage DQS 0 to 50
High level Absolute DQS -10 to 10
Mid level Absolute DQS
Low level Absolute DQS
Hysteresis Absolute DQS 0 to 10

Rd_Data Number of UI value 0.001 to 2000
Worst Case Logging • True

• False

tCK Value 0.1 to 10
DQS Reference Level Slew Rate ref level DQS • Auto

• Manual

Ref Levels Autoset Basetop
Method DQS

• AUTO
• MINMAX

Ref levels DQS • Absolute
• Percentage

High level Percentage DQS 1 to 99
Mid level Percentage DQS
Low level Percentage DQS
Hysteresis Percentage DQS 0 to 50
High level Absolute DQS -10 to 10
Mid level Absolute DQS
Low level Absolute DQS
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TestName ParameterName ParameterValue
Hysteresis Absolute DQS 0 to 10

DQ Reference Level Slew Rate ref level DQ • Auto
• Manual

Ref Levels Autoset Basetop
Method DQ

• Auto
• Manual

Ref levels DQ • Absolute
• Percentage

High level Percentage DQ 1 to 99
Mid level Percentage DQ
Low level Percentage DQ
Hysteresis Percentage DQ 0 to 50
High level Absolute DQ -10 to 10
Mid level Absolute DQ
Low level Absolute DQ
Hysteresis Absolute DQ 0 to 10

Clock Reference Level Ref Levels Autoset Basetop
Method Clock

• AUTO
• MINMAX

Ref levels Clock • Absolute
• Percentage

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10

Table 25: For LPDDR5-5X

<TestName> <ParameterName> <ParameterValue>
Clock Window Size 200 to 1000000

Number of UI state • True
• False

Number of UI value 0.001 to 5000
Table continued…
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<TestName> <ParameterName> <ParameterValue>
Round Up • True

• False

Worst Case Logging • True
• False

Overshoot Ref Voltage -6 to 6
Undershoot Ref Voltage
Clock Reference Level Ref levels Clock • Absolute

• Percentage

High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10
High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
Slew Rate ref level • Auto

• Manual

Ref Levels Autoset Basetop
Method Clock

• MINMAX
• AUTO

Ref levels Clock Single Ended • Absolute
• Percentage

Ref Levels Autoset Basetop
Method Clock Single Ended

• AUTO
• MINMAX

High level Percentage Clock
Single Ended

1 to 99

Mid level Percentage Clock
Single Ended
Low level Percentage Clock
Single Ended
Hysteresis Percentage Clock
Single Ended

0 to 50

High level Absolute Clock Single
Ended

-10 to 10

Mid level Absolute Clock Single
Ended
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<TestName> <ParameterName> <ParameterValue>
Low level Absolute Clock Single
Ended
Hysteresis Absolute Clock Single
Ended

0 to 10

Write Clock Number of UI state • True
• False

Worst Case Logging • True
• False

Window Size 200 to 1000000
Round Up • True

• False

WCK Reference Level Ref levels WCK • Absolute
• Percentage

High level Percentage WCK 1 to 99
Mid level Percentage WCK
Low level Percentage WCK
Hysteresis Percentage WCK 0 to 50
High level Absolute WCK -10 to 10
Mid level Absolute WCK
Low level Absolute WCK
Hysteresis Absolute WCK 0 to 10
Ref Levels Autoset Basetop
Method WCK

• MINMAX
• AUTO

Ref Levels Autoset Basetop
Method WCK Single Ended

• MINMAX
• AUTO

Ref levels WCK Single Ended • Absolute
• Percentage

High level Percentage WCK
Single Ended

1 to 99

Mid level Percentage WCK
Single Ended
Low level Percentage WCK
Single Ended
Hysteresis Percentage WCK
Single Ended

0 to 50
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<TestName> <ParameterName> <ParameterValue>
High level Absolute WCK Single
Ended

-10 to 10

Mid level Absolute WCK Single
Ended
Low level Absolute WCK Single
Ended
Hysteresis Absolute WCK Single
Ended

0 to 10

Write Differential(WR_Data) Stop On Mask Hit • True
• False

Superimpose WCK • True
• False

Number of UI state • True
• False

Number of UI value 0.001 to 5000
Vertical Scale • Scale to DQ

• Scale to WCK

Include Margin In Plot • True
• False

tdivw1 Value 0 to 2
tdivw2 Value 0 to 2
vdivw Value 0 to 10
WCK Reference Level Ref levels WCK • Absolute

• Percentage

High level Percentage WCK 1 to 99
Mid level Percentage WCK
Low level Percentage WCK
Hysteresis Percentage WCK 0 to 50
High level Absolute WCK -10 to 10
Mid level Absolute WCK
Low level Absolute WCK
Hysteresis Absolute WCK 0 to 10
Ref Levels Autoset Basetop
Method WCK

• MINMAX
• AUTO

DQ Reference Level Ref Levels Autoset Basetop
Method DQ

• MINMAX
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<TestName> <ParameterName> <ParameterValue>

• AUTO

Slew Rate ref level • Auto
• Manual

Ref levels DQ • Absolute
• Percentage

High level Percentage DQ 1 to 99
Mid level Percentage DQ
Low level Percentage DQ
Hysteresis Percentage DQ 0 to 50
High level Absolute DQ -10 to 10
Mid level Absolute DQ
Low level Absolute DQ
Hysteresis Absolute DQ 0 to 10

Clock Reference Level Ref Levels Autoset Basetop
Method Clock

• MINMAX
• AUTO

Ref levels Clock • Absolute
• Percentage

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10

Read Differential(RD_Data) Number of UI state • True
• False

Number of UI value 0.001 to 5000
Superimpose RDQS • True

• False

Vertical Scale • Scale to DQ
• Scale to RDQS

RDQS Reference Level Ref Levels Autoset Basetop
Method RDQS

• MINMAX
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<TestName> <ParameterName> <ParameterValue>

• AUTO

Ref levels RDQS • Absolute
• Percentage

High level Percentage RDQS 1 to 99
Mid level Percentage RDQS
Low level Percentage RDQS
Hysteresis Percentage RDQS 0 to 50
High level Absolute RDQS -10 to 10
Mid level Absolute RDQS
Low level Absolute RDQS
Hysteresis Absolute RDQS 0 to 10
Slew Rate ref level RDQS • Auto

• Manual

DQ Reference Level Ref levels DQ • Absolute
• Percentage

Ref Levels Autoset Basetop
Method DQ

• AUTO
• MINMAX

High level Percentage DQ 1 to 99
Mid level Percentage DQ
Low level Percentage DQ
Hysteresis Percentage DQ 0 to 50
High level Absolute DQ -10 to 10
Mid level Absolute DQ
Low level Absolute DQ
Hysteresis Absolute DQ 0 to 10
Slew Rate ref level DQ • Auto

• Manual

CA Include Margin In Plot • True
• False

tcivw1 Value 0 to 2
tcivw2 Value 0 to 2
vcivw Value 0 to 10
Overshoot Ref Voltage -6 to 6
Undershoot Ref Voltage
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<TestName> <ParameterName> <ParameterValue>
Clock Reference Level Ref levels Clock • Absolute

• Percentage

Ref Levels Autoset Basetop
Method Clock

• AUTO
• MINMAX

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0 to 10

CA Reference Level Ref Levels Autoset Basetop
Method CA

• MINMAX
• AUTO

Ref levels CA • Absolute
• Percentage

High level Percentage CA 1 to 99
Mid level Percentage CA
Low level Percentage CA
Hysteresis Percentage CA 0 to 50
High level Absolute CA -10 to 10
Mid level Absolute CA
Low level Absolute CA
Hysteresis Absolute CA 0 to 10

CS Include Margin In Plot • True
• False

tcsivw1 Value 0 to 2
tcsivw2 Value 0 to 2
vcsivw Value 0 to 10
Overshoot Ref Voltage -6 to 6
Undershoot Ref Voltage
Clock Reference Level Ref Levels Autoset Basetop

Method Clock
• MINMAX
• AUTO

Ref levels Clock • Absolute
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<TestName> <ParameterName> <ParameterValue>

• Percentage

High level Percentage Clock 1 to 99
Mid level Percentage Clock
Low level Percentage Clock
Hysteresis Percentage Clock 0 to 50
High level Absolute Clock -10 to 10
Mid level Absolute Clock
Low level Absolute Clock
Hysteresis Absolute Clock 0to 10

CS Reference Level Ref Levels Autoset Basetop
Method CS

• MINMAX
• AUTO

Ref levels CS • Absolute
• Percentage

High level Percentage CS 1 to 99
Mid level Percentage CS
Low level Percentage CS
Hysteresis Percentage CS 0 to 50
High level Absolute CS -10 to 10
Mid level Absolute CS
Low level Absolute CS
Hysteresis Absolute CS 0 to 10

Write Single Ended Number of UI state • True
• False

Number of UI value 0.001 to 5000
Overshoot Ref Voltage Data -6 to 6
Undershoot Ref Voltage Data
WCK Reference Level Ref Levels Autoset Basetop

Method WCK Single Ended
• MINMAX
• AUTO

Ref levels WCK Single Ended • Absolute
• Percentage

High level Percentage WCK
Single Ended

1 to 99

Mid level Percentage WCK
Single Ended
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<TestName> <ParameterName> <ParameterValue>
Low level Percentage WCK
Single Ended
Hysteresis Percentage WCK
Single Ended

0 to 50

High level Absolute WCK Single
Ended

-10 to 10

Mid level Absolute WCK Single
Ended
Low level Absolute WCK Single
Ended
Hysteresis Absolute WCK Single
Ended

0 to 10

DQ Reference Level Ref Levels Autoset Basetop
Method DQ Single Ended

• MINMAX
• AUTO

Ref levels DQ Single Ended • Absolute
• Percentage

High level Percentage DQ Single
Ended

1 to 99

Mid level Percentage DQ Single
Ended
Low level Percentage DQ Single
Ended
Hysteresis Percentage DQ
Single Ended

0 to 50

High level Absolute DQ Single
Ended

-10 to 10

Mid level Absolute DQ Single
Ended
Low level Absolute DQ Single
Ended
Hysteresis Absolute DQ Single
Ended

0 to 10

Read Single Ended Number of UI state • True
• False

Number of UI value 0.001 to 5000
Overshoot Ref Voltage Data -6 to 6
Undershoot Ref Voltage Data
RDQS Reference Level Ref Levels Autoset Basetop

Method RDQS Single Ended
• MINMAX
• AUTO
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<TestName> <ParameterName> <ParameterValue>
Ref levels RDQS Single Ended • Absolute

• Percentage

High level Percentage RDQS
Single Ended

1 to 99

Mid level Percentage RDQS
Single Ended
Low level Percentage RDQS
Single Ended
Hysteresis Percentage RDQS
Single Ended

0 to 50

High level Absolute RDQS Single
Ended

-10 to 10

Mid level Absolute RDQS Single
Ended
Low level Absolute RDQS Single
Ended
Hysteresis Absolute RDQS
Single Ended

0 to 10

DQ Reference Level Ref Levels Autoset Basetop
Method DQ Single Ended

• MINMAX
• AUTO

Ref levels DQ Single Ended • Absolute
• Percentage

High level Percentage DQ Single
Ended

1 to 99

Mid level Percentage DQ Single
Ended
Low level Percentage DQ Single
Ended
Hysteresis Percentage DQ
Single Ended

0 to 50

High level Absolute DQ Single
Ended

-10 to 10

Mid level Absolute DQ Single
Ended
Low level Absolute DQ Single
Ended
Hysteresis Absolute DQ Single
Ended

0 to 10

Returns
<Nrf>

SCPI Commands

104



Examples
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" command set the
value for the specified test and its analyze parameter.

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" command returns the value for the specified test
and its analyze parameter.

Query the available devices in the DUT panel of the application
This command queries the list of available devices on the DUT panel as comma separated values.

Syntax
TEKEXP:LIST? DEVICE (Query)

Command arguments
Device Device Type and value Description
<Device> DDR5LPDDR5-5X It is the name of the device on the DUT panel of the application.

Returns
<String>

Examples
TEKEXP:LIST? DEVICE command returns the list of available devices.

Query the list of available tests of the application
This command queries the list of available tests of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? TEST (Query)
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Command arguments
Table 26: For DDR5

<TestName> <String>
Clock Group measurements • tCK

• tCK_Duty_UI_Error
• tCK_1UI_RJ_NoBUJ
• tCK_1UI_DJ_NoBUJ
• tCK_1UI_TJ_NoBUJ
• tCK_2UI_RJ_NoBUJ
• tCK_2UI_DJ_NoBUJ
• tCK_2UI_TJ_NoBUJ
• tCK_3UI_RJ_NoBUJ
• tCK_3UI_DJ_NoBUJ
• tCK_3UI_TJ_NoBUJ
• tCK_NUI_RJ_NoBUJ
• tCK_NUI_DJ_NoBUJ
• tCK_NUI_TJ_NoBUJ
• VIHdiff.CK(AC)
• VIHdiff.CK(DC)
• VILdiff.CK(AC)
• VILdiff.CK(DC)
• SRIdiff-Rise
• SRIdiff-Fall
• VIX_CK_Ratio

Write Burst measurements • Eye-Height_Write
• Eye-Width_Write
• Eye-Jitter_Write
• VcentDq
• tWPRE
• tWPST
• tDQS2DQ
• tDQSS
• tDSS
• tDSH
• RxMask
• InputSlew-Diff-Rise(DQS)
• InputSlew-Diff-Fall(DQS)
• VIX_DQS_Ratio

Table continued…
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<TestName> <String>
Read Burst measurements • Eye-Height_Read

• Eye-Width_Read
• Eye-Jitter_Read
• tRPRE
• tRPST
• tDQSCK
• VOHdiffAC
• VOLdiffAC
• VOH(AC)
• VOH(DC)
• VOL(AC)
• VOL(DC)
• SRQdiff-Rise(DQS)
• SRQdiff-Fall(DQS)
• SRQse-Rise(DQ)
• SRQse-Fall(DQ)

Address Command measurements • VIHL_AC
• RxMask_CA
• VciVW
• TciVW
• TCiPW
• VcentCa
• SRIN_cIVW_Rise
• SRIN_cIVW_Fall
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Table 27: For LPDDR5-5X

<TestName> <String>
Clock • tCH(abs)

• tCH(avg)
• tCK(avg)
• tCK(abs)
• tCL(avg)
• tCL(abs)
• tJIT(cc)
• tJIT(per)
• VIHdiff_CK
• VILdiff_CK
• Vindiff_CK
• Vindiff_High_CK
• Vindiff_Low_CK
• SRIdiff_Rise_CK
• SRIdiff_Fall_CK
• Overshoot_Amplitude_CK_t
• Overshoot_Area_CK_t
• Overshoot_Amplitude_CK_c
• Overshoot_Area_CK_c
• Undershoot_Amplitude_CK_t
• Undershoot_Area_CK_t
• Undershoot_Amplitude_CK_c
• Undershoot_Area_CK_c
• VIHdiff_CK
• VILdiff_CK
• Vindiff_CK
• Vindiff_High_CK
• Vindiff_Low_CK
• Vinse_CK_t
• Vinse_High_CK_t
• Vinse_Low_CK_t
• Vinse_CK_c
• Vinse_High_CK_c
• Vinse_Low_CK_c
• SRIdiff_Rise_CK
• SRIdiff_Fall_CK
• VIX_CK_Ratio
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<TestName> <String>
Write Clock • tWCKH(avg)

• tWCKH(abs)
• tWCKL(avg)
• tWCKL(abs)
• tWCK(avg)
• tWCK(abs)
• tJIT(cc)_WCK
• tJIT(per)_WCK
• tERR(2per)
• tERR(3per)
• tERR(4per)

Read Burst Measurements • tRPRE
• tRPST
• tQH
• tDQSQ
• tQW
• tQSH
• tQSL
• SRQdiff_Rise_RDQS
• SRQdiff_Fall_RDQS
• SRQse_Rise_DQ
• SRQse_Fall_DQ
• Overshoot_Amplitude_RDQS_t
• Overshoot_Area_RDQS_t
• Undershoot_Amplitude_RDQS_t
• Undershoot_Area_RDQS_t
• Overshoot_Amplitude_RDQS_c
• Overshoot_Area_RDQS_c
• Undershoot_Amplitude_RDQS_c
• Undershoot_Area_RDQS_c
• Overshoot_Amplitude_RD_DQ
• Overshoot_Area_RD_DQ
• Undershoot_Amplitude_RD_DQ
• Undershoot_Area_RD_DQ

Table continued…
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<TestName> <String>
Write Burst Measurements • RxMask_Write

• tDIVW1
• tDIVW2
• vDIVW
• tDIPW
• tDIHL_Above
• tDIHL_Below
• vDIHL_AC
• tWCK2DQI
• VIX_WCK_Ratio
• tWCK2CK
• VcentDQ
• tDIPW1
• tDIPW2
• vDIHP1
• vDILP1
• vDIHP2
• vDILP2
• VIHdiff_WCK
• VILdiff_WCK
• Vindiff_WCK
• Vindiff_High_WCK
• Vindiff_Low_WCK
• SRIdiff_Rise_WCK
• SRIdiff_Fall_WCK
• tDQ2DQ
• Overshoot_Amplitude_WCK_t
• Overshoot_Area_WCK_t
• Undershoot_Amplitude_WCK_t
• Undershoot_Area_WCK_t
• Overshoot_Amplitude_WCK_c
• Overshoot_Area_WCK_c
• Undershoot_Amplitude_WCK_c
• Undershoot_Area_WCK_c
• Overshoot_Amplitude_WR_DQ
• Overshoot_Area_WR_DQ
• Undershoot_Amplitude_WR_DQ
• Undershoot_Area_WR_DQ
• Vinse_WCK_t
• Vinse_High_WCK_t
• Vinse_Low_WCK_t
• Vinse_WCK_c
• Vinse_High_WCK_c
• Vinse_Low_WCK_c
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<TestName> <String>
CA Measurements • RXMask_CA

• tCIVW1
• tCIVW2
• vCIVW
• TcIPW_Positive
• TcIPW_Negative
• vCIHL_AC
• VcentCA
• Overshoot_Amplitude_CA
• Overshoot_Area_CA
• Undershoot_Amplitude_CA
• Undershoot_Area_CA
• tCA2CA

CS Measurements • RXMask_CS
• tCSIPW_Negative
• tCSIPW_Positive
• vCSIHL_AC
• tCSIVW1
• tCSIVW2
• vCSIVW
• VcentCS
• Overshoot_Amplitude_CS
• Overshoot_Area_CS
• Undershoot_Amplitude_CS
• Undershoot_Area_CS

Returns
<String>

Examples
TEKEXP:LIST? TEST command returns the list of available tests for the selected device.

Query the list of available instruments based on the specified instrument type
This command queries the list of available instruments based on the specified instrument type.

Syntax
TEKEXP:LIST? INSTRUMENT,"<InstrumentType>" (Query)

Command argument
Argument Name Argument value
<InstrumentType> <String>
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Returns
<String>

Examples
TEKEXP:LIST? INSTRUMENT,"Real Time Scope" command returns the list of available instruments based on the real
time scope type.

Set or query the IP address of the instrument based on the specified instrument
type
This command sets or queries the IP address of the instrument based on the specified instrument type.

Syntax
TEKEXP:INSTRUMENT? "<InstrumentType>" (Query)

TEKEXP:INSTRUMENT, "<InstrumentType>","<Value>" (Set)

Command argument
Argument Name Argument Type
<InstrumentType> <String>
<Value> <String>

TCPIP::XXX.XX.XXX.XXX::INSTR

Returns
<String>

Examples
TEKEXP:INSTRUMENT? "<InstrumentType>" command returns the IP address of the oscilloscope.

TEKEXP:INSTRUMENT, "<InstrumentType>","<value>" command sets the oscilloscope to the specified IP address.

Query the information of the generated report file
This command queries the information of the generated report file in the format "<FileSize>","<FileName>".

Pre‐requisite
A session should be run earlier and the report should be generated to get the information of the report.

Syntax
TEKEXP:INFO? REPORT (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? REPORT command returns the information of the generated report in the format ("1215”,"DUT001.mht”).
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Query the information of the generated waveform files
This command queries the information of the generated waveform files in the format.

<File1Size,"File1Name”>.

If there are more than one waveform, the waveform file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? WFM (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? WFM command returns the information of the generated waveform in the format (20000858,"X:\<Application
Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short Record‐length for SCOPE Period_NoSSC_DIFF.wfm”).

Query the information of the generated image files
This command queries the information of the generated image files in the format.

<File1Size,"File1Name”>.

If there are more than one image, the image file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? IMAGE (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? IMAGE command returns the information of the generated image
in the format (109058, "X:\<Application Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short
Record‐length for SCOPE Period_NoSSC_DIFF.png";22794,"X:\<Application Name>\UntitledSession\DUT001\20
200916_041609\ScopePeriodPlot_Iteration1WithCursor.png").

Query the active TekExpress application name
This command queries the active TekExpress application name running on the oscilloscope.

Syntax
TEKEXP:*IDN? (Query)

Returns
<String>
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Examples
TEKEXP:*IDN? command returns the active TekExpress application name running on the oscilloscope.

Sets or query the acquire mode status
This command sets or queries the acquire mode status.

Syntax
TEKEXP:ACQUIRE_MODE <Mode> (Set)

TEKEXP:ACQUIRE_MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • LIVE

• PRE‐RECORDED

Returns
LIVE | PRE‐RECORDED

Examples
TEKEXP:ACQUIRE_MODE LIVE command sets the acquire mode to the Live mode.

TEKEXP:ACQUIRE_MODE? command returns the current acquire mode.

Set or query the execution mode status
This command sets or queries the execution mode status.

Syntax
TEKEXP:MODE <Mode> (Set)

TEKEXP:MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • COMPLIANCE

• USER‐DEFINED

Returns
COMPLIANCE | USER‐DEFINED

Examples
TEKEXP:MODE COMPLIANCE command sets the execution mode to the compliance mode.

TEKEXP:MODE? command returns the current execution mode.
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Generate the report for the current session
This command generates the report for the current session.

Syntax
TEKEXP:REPORT GENERATE(Set)

Arguments
N/A

Examples
TEKEXP:REPORT GENERATE command generates the report for the current session.

Query the value of specified report header field in the report
This command queries the value of specified report header field in the report.

Syntax
TEKEXP:REPORT? ”<Device Field>” (Query)

Command arguments
Argument Name Argument Type
<Device Field>

Device field is the header name of each field in the setup
information section of the report.

<String>

Returns
<String>

Examples
TEKEXP:REPORT? "DUT ID" command returns the value of DUT ID field in the report.

Query the value of specified result detail available in report summary/details
table
This command queries the value of specified result detail available in report summary/details table.

Syntax
TEKEXP:RESULT? "<TestName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> (Query)
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Command arguments
Argument Name Argument Type
<TestName>

It is the test name of which the details are required in the report.

<String>

<ColumnName>

It is the column header name of which the details are required in the
report.

<String>

<RowNumber>

It is the row number of which the details are required in the report.

<String>

Returns
<String>

Examples
TEKEXP:RESULT? "<TestName>" will return the pass fail status of test.

TEKEXP:RESULT? "<TestName>","<ColumnName>" will return all the row values of specific column for the test with
comma separated values.

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> will return the column value of specified row
number.

Restore the setup to default settings
This command restores the setup to default settings.

Syntax
TEKEXP:SETUP Default (Set)

Arguments
N/A

Examples
TEKEXP:SETUP Default command restores the setup to default settings.

Save the settings to a specified session
This command saves the settings to a specified session.

Syntax
TEKEXP:SETUP Save,"<SessionName>"
Command arguments
Argument Name Argument value
<SessionName> <String>
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Examples
TEKEXP:SETUP Save,"<SessionName>" command saves the settings to a specified session.

Save the setup
This command saves the setup.

Syntax
TEKEXP:SETUP Save (Set)

Examples
TEKEXP:SETUP Save command saves the setup.

Open the setup from a specified session
This command opens the setup from a specified session.

Syntax
TEKEXP:SETUP Open,"<SessionName>" (Set)

Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Open,"<SessionName>" command opens the setup from a specified session.

Query the current setup file name
This command queries the current setup file name.

Syntax
TEKEXP:SETUP? CURRENT (Query)

Returns
<String>

Examples
TEKEXP:SETUP? CURRENT command returns the current setup file name.

Run/stop/pause/resume the selected measurements execution in the application
This command run/stop/pause/resume the selected measurements execution in the application.

Syntax
TEKEXP:STATE <operation mode> (Set)
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Command arguments
Argument Name Argument value
<operation mode> • RUN

• STOP
• PAUSE
• RESUME

Returns
RUN | STOP | PAUSE | RESUME

Examples
TEKEXP:STATE RUN command runs the execution for the selected measurements.

Query the current measurement execution status
This command queries the current measurement execution status.

Syntax
TEKEXP:STATE? (Query)

Returns
RUNNING | PAUSED | WAIT | ERROR | READY

Examples
TEKEXP:STATE? command returns the current measurement execution status.

Query whether the current setup is saved or not saved
This command queries whether the current setup is saved or not saved.

Syntax
TEKEXP:STATE? SETUP (Query)

Returns
Saved or Not‐Saved

Examples
TEKEXP:STATE? SETUP command returns whether the current setup is saved or not saved.

Query the status of the previous command execution
This command queries whether the previous command execution is completed successfully.

Syntax
TEKEXP:*OPC? (Query)

SCPI Commands

118



Returns
{0 | 1} or {True | False}

1 or True indicates that command execution is successful.

0 or False indicates that command execution is failed.

Examples
TEKEXP:*OPC? command returns whether the previous command operation is completed successfully.

Query the last error occurred
This command queries the last error occurred.

Syntax
TEKEXP:LASTERROR? (Query)

Returns
<String>

Examples
TEKEXP:LASTERROR? command returns the last error occurred.

Set or query the popup details
This command sets or queries the popup details.

Syntax
TEKEXP:POPUP? (Query)

TEKEXP:POPUP "<PopupResponse>" (Set)

Command arguments
Argument Name Argument value
<PopupResponse> • Yes

• No

Returns
The pop‐up details return in the following format:

"<Tittle>","<message>","<response1>,<response2>".

Where,

<Tittle> :: <String>

<message> :: <String>

<response1>,<response2> :: <String>
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Examples
TEKEXP:POPUP? command returns the popup details in following format ": "Do you really want to exit TekExpress?";Responses: "Yes,
No".

TEKEXP:POPUP "Yes" command sets the popup response to Yes.

Query the enable or disable status of Continuous run function.
This command queries the enable or disable status of Continuous run function.

Syntax
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" (Query)

Returns
{True | False} or {0 | 1}

Where,

1 or True indicates that the continuous run function is enabled.

0 or False indicates that the continuous run function is disabled.

Examples
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" command returns the enable or disable status of continuous run
function.

Set or query the continuous run duration time value
This command sets or queries the continuous run duration time value.

Syntax
TEKEXP:VALUE? ContinuousRun_Duration (Query)

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" (Set)

Arguments
Argument Name Argument value
<Value> Infinite | hh:mm

Infinite sets the radio on button to infinite.

hh:mm sets the continuous run duration to the specified time in
hours and minutes. The minimum time duration you can set is
00:30.

Returns
Infinite | hh:mm

Examples
TEKEXP:VALUE? ContinuousRun_Duration command returns the continuous run duration time value.

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" command sets the continuous run duration time value.
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Set or query the session create option in the continuous run function
This command sets or queries the option for session creation in the continuous run function.

Syntax
TEKEXP:VALUE? ContinuousRun_RunSessionOptions (Query)

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" (Set)

Arguments
Argument Name Argument value
<Value> NewSession | SameSession_ClearResults

NewSession - creates new session for each run.

SameSession_ClearResults - Clears the test results of the current
session and starts the test execution. The session results will be
added in the same session, by erasing the previous run results.

Returns
NewSession | SameSession_ClearResults

Examples
TEKEXP:VALUE? ContinuousRun_RunSessionOptions command returns the option for session creation in the
continuous run function.

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" command sets the option for session creation in the
continuous run function.

Set or query the View report after generating option status
This command sets or queries the enable/disable status of the View report after generating function.

Syntax
TEKEXP:VALUE? GENERAL,"View Report After Generating" (Query)

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> (Set)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}
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Examples
TEKEXP:VALUE? GENERAL,"View Report After Generating" command returns the enable or disable status of
view report after generating option.

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> command enable or disable the view
report after generating option.

Examples
This section provides the examples for the SCPI commands.

Table 28: Applicable for both DDR5 and LPDDR5-5X

Example Description
TEKEXP:*IDN?\n It returns the active TekExpress application

name running on the scope.
TEKEXP:*OPC?\n It returns the last command execution status.
TEKEXP:ACQUIRE_MODE PRE-RECORDED\n It sets the acquire mode as pre-recorded.
TEKEXP:ACQUIRE_MODE?\n It returns LIVE when acquire mode is set to

live.
TEKEXP:EXPORT REPORT\n It returns the report file in bytes. This can be

written into another file for further analysis.
TEKEXP:INFO? REPORT\n It returns “100,”ReportFileName.mht”", when

100 is the file size in bytes for the filename
ReportFileName.

TEKEXP:INFO? WFM\n It returns “100,“WfmFileName1.wfm”";“200,
“WfmFileName2.wfm”" when 100 is the
filesize in bytes for the filename
WfmFileName1.wfm and 200 is the
file size in bytes for the filename
WfmFileName2.wfm.

TEKEXP:VALUE GENERAL,"Bandwidth20GHz",19 It sets the bandwidth to 19 GHz.
TEKEXP:VALUE? GENERAL,"Bandwidth20GHz" It queries the Bandwidth set and returns the

value in GHz.
TEKEXP:INSTRUMENT "Real Time Scope",MSO58
( GPIB8::1::INSTR )\n

It sets the instrument value as MSO58
( GPIB8::1::INSTR ) for the selected
instrument type Real Time Scope.

TEKEXP:INSTRUMENT? “Real Time Scope”\n It returns "MSO56 ( GPIB8::1::INSTR ),
when MSO56 ( GPIB8::1::INSTR )" is the
selected instrument for the instrument type
Real Time Scope.

TEKEXP:LASTERROR?\n It returns ERROR:
INSTRUMENT_NOT_FOUND, when no
instrument is found.

TEKEXP:LIST? DEVICE\n It returns "TX-Device,RX-Device" when TX-
Device, RX-Device are the available device.

Table continued…
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Example Description
TEKEXP:LIST? INSTRUMENT,"Real Time Scope"\n It returns "MSO58

( GPIB8::1::INSTR ),MSO56
( TCPIP::134.64.248.91::INSTR )" when
MSO58 ( GPIB8::1::INSTR ), MSO56
( TCPIP::134.64.248.91::INSTR ) are the list
of available instruments.

TEKEXP:MODE?\n It returns COMPLIANCE when the execution
mode is compliance.

TEKEXP:POPUP “OK”\n It sets OK as the response to active popup in
the application.

TEKEXP:POPUP?\n It returns "OK", when OK is the active popup
information shown in the application.

TEKEXP:REPORT GENERATE\n It generates report for the current session.
TEKEXP:REPORT? “Scope Model”\n It returns "MSO54" when MSO54 is the

scope model.
TEKEXP:REPORT? “DUT ID”\n It returns "DUT001" when DNI_DUT001 is

the DUT ID.
TEKEXP:SELECT DEVICE, TX_Device, TRUE\n It selects TX_Device
TEKEXP:SELECT? DEVICE\n It returns "TX-Device" when TX-Device is the

selected device type.
TEKEXP:SETUP DEFAULT\n It restores the application to default setup.
TEKEXP:STATE STOP\n It stops the test execution.
TEKEXP:STATE?\n It returns as READY when the application is

ready to run next measurement.
TEKEXP:STATE? SETUP\n It returns as NOT_SAVED when the current

setup is not saved.
TEKEXP:VALUE GENERAL,"DataRate", 3600 It sets the data rate to 3600.
TEKEXP:VALUE? GENERAL,"DataRate" It returns the data rate that is currently set.
TEKEXP:VALUE GENERAL, "Clock Signal Probe Type",
"Single Ended"

It sets the clock signal probe type to single
ended.

TEKEXP:VALUE? GENERAL, "Clock Signal Probe Type" It returns the clock signal probe type as
Differential or Single Ended.

TEKEXP:SELECT TEST ,"tck",True It selects the measurement "tCK".
TEKEXP:VALUE? GENERAL "Record Length (mpts)" It returns the record length set.
TEKEXP:VALUE GENERAL "Record Length (mpts)",0.5 It sets the global configuration parameter

value of Record Length to 0.5mpts.
TEKEXP:VALUE? ANALYZE, "tCK_NUI_RJ_NoBUJ", "N value
Start"

It returns the value of the analyze parameter
Start N Value for the specified measurement.

TEKEXP:VALUE ANALYZE, "tCK_NUI_RJ_NoBUJ", "N value
Start", 4

It sets the Analyze parameter's low range for
N value to 4 for the specified measurement.

Table continued…
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Example Description
TEKEXP:VALUE GENERAL "DQ_Write Connected to Filter
File","C:\Users\Public\Automation\FilterFiles\Clock_50G
Ss.flt"

It sets the filter file for DQ Write signal.

TEKEXP:VALUE? GENERAL "DQ_Write Connected to Filter
File"

It queries the filter file used for Write DQ
signal.

TEKEXP:USER_DEF_ACQ? It queries the User Defined Acquisition
status.

TEKEXP:USER_DEF_ACQ TRUE It enables User Defined Acquisition.
TEKEXP:VALUE GENERAL,"Run Test More than Once","True" This enables the multi-run option.
TEKEXP:VALUE? GENERAL,"Run Test More than Once" It returns the enable and disable status of

multi-run option.
TEKEXP:VALUE GENERAL,"Number of Runs",5 It sets the number of iterations that the

measurement has to run.
TEKEXP:VALUE? GENERAL,"Number of Runs" It returns the number of iterations that the

measurements will run.
EKEXP:VALUE GENERAL,"Sample Rate (GS/s)",50 Set the Sample Rate to 50 GS/s.
TEKEXP:VALUE? GENERAL,"Sample Rate (GS/s)" It returns the value for Sample Rate.

Table 29: For DDR5

ParameterName Example to set Example to query
DataRate TEKEXP:VALUE

GENERAL,"DataRate","3200"
TEKEXP:VALUE?
GENERAL,"DataRate"

Custom DataRate TEKEXP:VALUE
GENERAL,"Custom
DataRate","1600"

TEKEXP:VALUE?
GENERAL,"Custom DataRate"

Burst Detection Method TEKEXP:VALUE GENERAL,"Burst
Detection Method","Read
Only Bursts"

TEKEXP:VALUE?
GENERAL,"Burst Detection
Method"

RB:DQ/DQS Phase Alignment:Burst
Detection Level Type

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Detection
Level Type","Manual"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Detection
Level Type"

RB:DQ/DQS Phase Alignment:Pre-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Pre-amble Length
(tCK)","1"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Pre-amble Length
(tCK)"

RB:DQ/DQS Phase Alignment:Post-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)"

RB:DQ/DQS Phase Alignment:Burst Length TEKEXP:VALUE
GENERAL,"RB:DQ/DQS

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Length"
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ParameterName Example to set Example to query
Phase Alignment:Burst
Length","16"

RB:DQ/DQS Phase Alignment:Burst(pk-pk) TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst(pk-pk)","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst(pk-pk)"

RB:DQ/DQS Phase Alignment:Margin(%) TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin(%)","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin(%)"

RB:DQ/DQS Phase
Alignment:BurstDetectionMode

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:BurstDetectionMod
e","Auto"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:BurstDetectionMod
e"

RB:DQ/DQS Phase
Alignment:IsReadWriteGreater

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:IsReadWriteGreate
r","No"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:IsReadWriteGreate
r"

RB:DQ/DQS Phase Alignment:Strobe High TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe High","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe High"

RB:DQ/DQS Phase Alignment:Strobe Mid TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Mid","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Mid"

RB:DQ/DQS Phase Alignment:Strobe Low TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Low","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Low"

RB:DQ/DQS Phase Alignment:Data High TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data High","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data High"

RB:DQ/DQS Phase Alignment:Data Mid TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Mid","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Mid"

RB:DQ/DQS Phase Alignment:Data Low TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Low","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Low"

RB:DQ/DQS Phase Alignment:Hysteresis TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Hysteresis","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Hysteresis"

RB:DQ/DQS Phase Alignment:Margin TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin"

WB:DQ/DQS Phase Alignment:tDQS2DQ
Type

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS
Phase Alignment:tDQS2DQ
Type","Auto"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:tDQS2DQ Type"
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ParameterName Example to set Example to query
WB:DQ/DQS Phase Alignment:tDQS2DQ
Value (ps)

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:tDQS2DQ Value
(ps)","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:tDQS2DQ VALUE?
(ps)"

WB:DQ/DQS Phase Alignment:Burst
Detection Level Type

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Detection
Level Type","Auto"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Detection
Level Type"

WB:DQ/DQS Phase Alignment:Pre-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Pre-amble Length
(tCK)","2"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Pre-amble Length
(tCK)"

WB:DQ/DQS Phase Alignment:Post-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)"

WB:DQ/DQS Phase Alignment:Burst Length TEKEXP:VALUE
GENERAL,"WB:DQ/DQS
Phase Alignment:Burst
Length","16"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Length"

WB:DQ/DQS Phase Alignment:Burst(pk-pk) TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst(pk-pk)","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst(pk-pk)"

WB:DQ/DQS Phase Alignment:Margin(%) TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin(%)","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin(%)"

WB:DQ/DQS Phase
Alignment:BurstDetectionMode

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:BurstDetectionMod
e","Auto"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:BurstDetectionMod
e"

WB:DQ/DQS Phase
Alignment:IsReadWriteGreater

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:IsReadWriteGreate
r","No"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:IsReadWriteGreate
r"

WB:DQ/DQS Phase Alignment:Strobe High TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe High","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe High"

WB:DQ/DQS Phase Alignment:Strobe Mid TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Mid","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Mid"

WB:DQ/DQS Phase Alignment:Strobe Low TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Low","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Low"

WB:DQ/DQS Phase Alignment:Data High TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Data High","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data High"
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WB:DQ/DQS Phase Alignment:Data Mid TEKEXP:VALUE

GENERAL,"WB:DQ/DQS Phase
Alignment:Data Mid","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Mid"

WB:DQ/DQS Phase Alignment:Data Low TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Low","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Low"

WB:DQ/DQS Phase Alignment:Hysteresis TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Hysteresis","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Hysteresis"

WB:DQ/DQS Phase Alignment:Margin TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin","1"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin"

Read Burst:Burst Detection Level Type TEKEXP:VALUE GENERAL,"Read
Burst:Burst Detection Level
Type","Auto"

TEKEXP:VALUE? GENERAL,"Read
Burst:Burst Detection Level
Type"

Read Burst:Pre-amble Length (tCK) TEKEXP:VALUE GENERAL,"Read
Burst:Pre-amble Length
(tCK)","1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Pre-amble Length
(tCK)"

Read Burst:Post-amble Length (tCK) TEKEXP:VALUE GENERAL,"Read
Burst:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE? GENERAL,"Read
Burst:Post-amble Length
(tCK)"

Read Burst:Burst Length TEKEXP:VALUE GENERAL,"Read
Burst:Burst Length","16"

TEKEXP:VALUE? GENERAL,"Read
Burst:Burst Length"

Read Burst:Strobe High TEKEXP:VALUE GENERAL,"Read
Burst:Strobe High","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe High"

Read Burst:Strobe Mid TEKEXP:VALUE GENERAL,"Read
Burst:Strobe Mid","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe Mid"

Read Burst:Strobe Low TEKEXP:VALUE GENERAL,"Read
Burst:Strobe Low","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe Low"

Read Burst:Data High TEKEXP:VALUE GENERAL,"Read
Burst:Data High","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data High"

Read Burst:Data Mid TEKEXP:VALUE GENERAL,"Read
Burst:Data Mid","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data Mid"

Read Burst:Data Low TEKEXP:VALUE GENERAL,"Read
Burst:Data Low","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data Low"

Read Burst:Hysteresis TEKEXP:VALUE GENERAL,"Read
Burst:Hysteresis","1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Hysteresis"

Read Burst:Margin TEKEXP:VALUE GENERAL,"Read
Burst:Margin","1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Margin"

Write Burst:Burst Detection Level Type TEKEXP:VALUE GENERAL,"Write
Burst:Burst Detection Level
Type","Auto"

TEKEXP:VALUE?
GENERAL,"Write Burst:Burst
Detection Level Type"
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Write Burst:Pre-amble Length (tCK) TEKEXP:VALUE GENERAL,"Write

Burst:Pre-amble Length
(tCK)","2"

TEKEXP:VALUE?
GENERAL,"Write Burst:Pre-
amble Length (tCK)"

Write Burst:Post-amble Length (tCK) TEKEXP:VALUE GENERAL,"Write
Burst:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE?
GENERAL,"Write Burst:Post-
amble Length (tCK)"

Write Burst:Burst Length TEKEXP:VALUE GENERAL,"Write
Burst:Burst Length","16"

TEKEXP:VALUE?
GENERAL,"Write Burst:Burst
Length"

Write Burst:tDQS2DQ Type TEKEXP:VALUE GENERAL,"Write
Burst:tDQS2DQ Type","Auto"

TEKEXP:VALUE?
GENERAL,"Write
Burst:tDQS2DQ Type"

Write Burst:tDQS2DQ Value (ps) TEKEXP:VALUE GENERAL,"Write
Burst:tDQS2DQ Value
(ps)","1"

TEKEXP:VALUE?
GENERAL,"Write
Burst:tDQS2DQ Value (ps)"

Write Burst:Strobe High TEKEXP:VALUE GENERAL,"Write
Burst:Strobe High","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
High"

Write Burst:Strobe Mid TEKEXP:VALUE GENERAL,"Write
Burst:Strobe Mid","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
Mid"

Write Burst:Strobe Low TEKEXP:VALUE GENERAL,"Write
Burst:Strobe Low","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
Low"

Write Burst:Data High TEKEXP:VALUE GENERAL,"Write
Burst:Data High","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
High"

Write Burst:Data Mid TEKEXP:VALUE GENERAL,"Write
Burst:Data Mid","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
Mid"

Write Burst:Data Low TEKEXP:VALUE GENERAL,"Write
Burst:Data Low","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
Low"

Write Burst:Hysteresis TEKEXP:VALUE GENERAL,"Write
Burst:Hysteresis","1"

TEKEXP:VALUE?
GENERAL,"Write
Burst:Hysteresis"

Write Burst:Margin TEKEXP:VALUE GENERAL,"Write
Burst:Margin","1"

TEKEXP:VALUE?
GENERAL,"Write
Burst:Margin"

Visual Search Burst Detection Area TEKEXP:VALUE
GENERAL,"Visual Search
Burst Detection
Area","Define visual
trigger area on the screen"

TEKEXP:VALUE?
GENERAL,"Visual Search
Burst Detection Area"
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VT Setup File TEKEXP:VALUE GENERAL,"VT

Setup File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE? GENERAL,"VT
Setup File"

Clock Signal Probe Type TEKEXP:VALUE GENERAL,"Clock
Signal Probe
Type","Differential"

TEKEXP:VALUE?
GENERAL,"Clock Signal Probe
Type"

DQS Signal Probe Type TEKEXP:VALUE GENERAL,"DQS
Signal Probe
Type","Differential"

TEKEXP:VALUE? GENERAL,"DQS
Signal Probe Type"

Vdd TEKEXP:VALUE
GENERAL,"Vdd","Manual"

TEKEXP:VALUE? GENERAL,"Vdd"

Vdd Display TEKEXP:VALUE GENERAL,"Vdd
Display","1"

TEKEXP:VALUE? GENERAL,"Vdd
Display"

Vcent_DQ TEKEXP:VALUE
GENERAL,"Vcent_DQ","Auto_Vc
ent"

TEKEXP:VALUE?
GENERAL,"Vcent_DQ"

Vcent_DQ Display TEKEXP:VALUE
GENERAL,"Vcent_DQ
Display","1"

TEKEXP:VALUE?
GENERAL,"Vcent_DQ Display"

Vcent_CA TEKEXP:VALUE
GENERAL,"Vcent_CA","Auto_Vc
ent_CA"

TEKEXP:VALUE?
GENERAL,"Vcent_CA"

Vcent_CA Display TEKEXP:VALUE
GENERAL,"Vcent_CA
Display","1"

TEKEXP:VALUE?
GENERAL,"Vcent_CA Display"

DQS Probe Mode TEKEXP:VALUE GENERAL,"DQS
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"DQS
Probe Mode"

Clock Probe Mode TEKEXP:VALUE GENERAL,"Clock
Probe Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock Probe Mode"

DQSPositive Probe Mode TEKEXP:VALUE
GENERAL,"DQSPositive Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"DQSPositive Probe
Mode"

DQSNegative Probe Mode TEKEXP:VALUE
GENERAL,"DQSNegative Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"DQSNegative Probe
Mode"

DQ Probe Mode TEKEXP:VALUE GENERAL,"DQ
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"DQ
Probe Mode"

ADDR CMD Probe Mode TEKEXP:VALUE GENERAL,"ADDR
CMD Probe Mode","A"

TEKEXP:VALUE? GENERAL,"ADDR
CMD Probe Mode"

Clock(+) Probe Mode TEKEXP:VALUE
GENERAL,"Clock(+) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock(+) Probe
Mode"
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Clock(-) Probe Mode TEKEXP:VALUE

GENERAL,"Clock(-) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock(-) Probe
Mode"

DeEmbed Filter Files TEKEXP:VALUE
GENERAL,"DeEmbed Filter
Files","Enable"

TEKEXP:VALUE?
GENERAL,"DeEmbed Filter
Files"

DQS_Read Connected to Filter File TEKEXP:VALUE
GENERAL,"DQS_Read Connected
to Filter File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQS_Read Connected
to Filter File"

DQS_Write Connected to Filter File TEKEXP:VALUE
GENERAL,"DQS_Write
Connected to Filter
File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQS_Write
Connected to Filter File"

Clock Connected to Filter File TEKEXP:VALUE GENERAL,"Clock
Connected to Filter
File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"Clock Connected to
Filter File"

DQS(+)_Write Connected to Filter File TEKEXP:VALUE
GENERAL,"DQS(+)_Write
Connected to Filter
File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQS(+)_Write
Connected to Filter File"

DQS(-)_Write Connected to Filter File TEKEXP:VALUE
GENERAL,"DQS(-)_Write
Connected to Filter
File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQS(-)_Write
Connected to Filter File"

DQ_Read Connected to Filter File TEKEXP:VALUE
GENERAL,"DQ_Read Connected
to Filter File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQ_Read Connected
to Filter File"

DQ_Write Connected to Filter File TEKEXP:VALUE
GENERAL,"DQ_Write Connected
to Filter File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"DQ_Write Connected
to Filter File"

CA Connected to Filter File TEKEXP:VALUE GENERAL,"CA
Connected to Filter
File","C:\Program

TEKEXP:VALUE? GENERAL,"CA
Connected to Filter File"
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Files\Tektronix\TekExpress\
TekExpress DDR Tx"

Clock(+) Connected to Filter File TEKEXP:VALUE
GENERAL,"Clock(+) Connected
to Filter File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"Clock(+) Connected
to Filter File"

Clock(-) Connected to Filter File TEKEXP:VALUE
GENERAL,"Clock(-) Connected
to Filter File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE?
GENERAL,"Clock(-) Connected
to Filter File"

Sample Rate (GS/s) NA TEKEXP:VALUE?
GENERAL,"Sample Rate
(GS/s)"

Record Length (mpts) TEKEXP:VALUE
GENERAL,"Record Length
(mpts)","0.001"

TEKEXP:VALUE?
GENERAL,"Record Length
(mpts)"

Bandwidth TEKEXP:VALUE
GENERAL,"Bandwidth","20"

TEKEXP:VALUE?
GENERAL,"Bandwidth"

Run Test More than Once TEKEXP:VALUE GENERAL,"Run
Test More than Once","True"

TEKEXP:VALUE? GENERAL,"Run
Test More than Once"

Number of Runs TEKEXP:VALUE
GENERAL,"Number of
Runs","3"

TEKEXP:VALUE?
GENERAL,"Number of Runs"

Retain Vertical Scale TEKEXP:VALUE
GENERAL,"Retain Vertical
Scale","True"

TEKEXP:VALUE?
GENERAL,"Retain Vertical
Scale"

Enable Logging TEKEXP:VALUE
GENERAL,"Enable
Logging","True"

TEKEXP:VALUE?
GENERAL,"Enable Logging"

DQ Connected to : Signal Selected TEKEXP:VALUE GENERAL,"DQ
Connected to : Signal
Selected","True"

TEKEXP:VALUE? GENERAL,"DQ
Connected to : Signal
Selected"

DQS Connected to : Signal Selected TEKEXP:VALUE GENERAL,"DQS
Connected to : Signal
Selected","True"

TEKEXP:VALUE? GENERAL,"DQS
Connected to : Signal
Selected"

DQS(+) Connected to : Signal Selected TEKEXP:VALUE
GENERAL,"DQS(+) Connected
to : Signal
Selected","True"

TEKEXP:VALUE?
GENERAL,"DQS(+) Connected
to : Signal Selected"

DQS(-) Connected to : Signal Selected TEKEXP:VALUE
GENERAL,"DQS(-) Connected
to : Signal
Selected","True"

TEKEXP:VALUE?
GENERAL,"DQS(-) Connected
to : Signal Selected"
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Clock Connected to : Signal Selected TEKEXP:VALUE GENERAL,"Clock

Connected to : Signal
Selected","True"

TEKEXP:VALUE?
GENERAL,"Clock Connected
to : Signal Selected"

Clock(+) Connected to : Signal Selected TEKEXP:VALUE
GENERAL,"Clock(+) Connected
to : Signal
Selected","True"

TEKEXP:VALUE?
GENERAL,"Clock(+) Connected
to : Signal Selected"

Clock(-) Connected to : Signal Selected TEKEXP:VALUE
GENERAL,"Clock(-) Connected
to : Signal
Selected","True"

TEKEXP:VALUE?
GENERAL,"Clock(-) Connected
to : Signal Selected"

CA Connected to : Signal Selected TEKEXP:VALUE GENERAL,"CA
Connected to : Signal
Selected","True"

TEKEXP:VALUE? GENERAL,"CA
Connected to : Signal
Selected"

Clock(+) Connected to TEKEXP:VALUE
GENERAL,"Clock(+) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"Clock(+) Connected
to"

Clock(-) Connected to TEKEXP:VALUE
GENERAL,"Clock(-) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"Clock(-) Connected
to"

Clock Connected to TEKEXP:VALUE GENERAL,"Clock
Connected to","CH1"

TEKEXP:VALUE?
GENERAL,"Clock Connected
to"

CA Connected to TEKEXP:VALUE GENERAL,"CA
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"CA
Connected to"

DQS Connected to TEKEXP:VALUE GENERAL,"DQS
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"DQS
Connected to"

DQS(+) Connected to TEKEXP:VALUE
GENERAL,"DQS(+) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"DQS(+) Connected
to"

DQS(-) Connected to TEKEXP:VALUE
GENERAL,"DQS(-) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"DQS(-) Connected
to"

DQ Connected to TEKEXP:VALUE GENERAL,"DQ
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"DQ
Connected to"

Table 30: For LPDDR5-5X

ParameterName Example to set Example to query
WCK:CK Ratio TEKEXP:VALUE

GENERAL,"WCK:CK
Ratio","4:1"

TEKEXP:VALUE?
GENERAL,"WCK:CK Ratio"

Clock Frequency NA TEKEXP:VALUE?
GENERAL,"Clock Frequency"
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WCK Frequency NA TEKEXP:VALUE? GENERAL,"WCK

Frequency"
DataRate TEKEXP:VALUE

GENERAL,"DataRate","40"
TEKEXP:VALUE?
GENERAL,"DataRate"

TEKEXP:VALUE
GENERAL,"DataRate","40"

TEKEXP:VALUE?
GENERAL,"DataRate"

Custom DataRate TEKEXP:VALUE
GENERAL,"Custom
DataRate","40"

TEKEXP:VALUE?
GENERAL,"Custom DataRate"

Burst Detection Method TEKEXP:VALUE GENERAL,"Burst
Detection Method","Visual
Search"

TEKEXP:VALUE?
GENERAL,"Burst Detection
Method"

RB:DQ/DQS Phase Alignment:Burst
Detection Level Type

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Detection
Level Type","Auto"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Detection
Level Type"

RB:DQ/DQS Phase Alignment:tDQSQ TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:tDQSQ","Auto"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:tDQSQ"

RB:DQ/DQS Phase Alignment:tDQSQ Value TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:tDQSQ Value","2"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:tDQSQ Value"

RB:DQ/DQS Phase Alignment:Pre-amble
Static (tWCK)

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Pre-amble Static
(tWCK)","2"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Pre-amble Static
(tWCK)"

RB:DQ/DQS Phase Alignment:PreAmble
Static Value

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:PreAmble Static
Value","4"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:PreAmble Static
Value"

RB:DQ/DQS Phase Alignment:Pre-amble
Toggle (tWCK)

NA TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Pre-amble Toggle
(tWCK)"

RB:DQ/DQS Phase Alignment:Post-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Post-amble Length
(tCK)"

RB:DQ/DQS Phase Alignment:Postamble
Mode

TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Postamble
Mode","Static"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Postamble Mode"

RB:DQ/DQS Phase Alignment:Burst Length TEKEXP:VALUE
GENERAL,"RB:DQ/DQS
Phase Alignment:Burst
Length","16"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Burst Length"
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RB:DQ/DQS Phase Alignment:Strobe High TEKEXP:VALUE

GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe High","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe High"

RB:DQ/DQS Phase Alignment:Strobe Mid TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Mid","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Mid"

RB:DQ/DQS Phase Alignment:Strobe Low TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Low","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Strobe Low"

RB:DQ/DQS Phase Alignment:Data High TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data High","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data High"

RB:DQ/DQS Phase Alignment:Data Mid TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Mid","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Mid"

RB:DQ/DQS Phase Alignment:Data Low TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Low","5"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Data Low"

RB:DQ/DQS Phase Alignment:Hysteresis TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Hysteresis","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Hysteresis"

RB:DQ/DQS Phase Alignment:Margin TEKEXP:VALUE
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin","0"

TEKEXP:VALUE?
GENERAL,"RB:DQ/DQS Phase
Alignment:Margin"

WB:DQ/DQS Phase Alignment:tWCK2DQI
Type

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS
Phase Alignment:tWCK2DQI
Type","Auto"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:tWCK2DQI Type"

WB:DQ/DQS Phase Alignment:tWCK2DQI
Value (ps)

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:tWCK2DQI Value
(ps)","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:tWCK2DQI Value
(ps)"

WB:DQ/DQS Phase Alignment:Burst
Detection Level Type

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Detection
Level Type","Auto"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Detection
Level Type"

WB:DQ/DQS Phase Alignment:Pre-amble
Static (tCK)

NA TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Pre-amble Static
(tCK)"

WB:DQ/DQS Phase Alignment:Pre-amble
Toggle (tCK)

NA TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Pre-amble Toggle
(tCK)"

WB:DQ/DQS Phase Alignment:Post-amble
Length (tCK)

TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
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Alignment:Post-amble Length
(tCK)","4.5"

Alignment:Post-amble Length
(tCK)"

WB:DQ/DQS Phase Alignment:Burst Length TEKEXP:VALUE
GENERAL,"WB:DQ/DQS
Phase Alignment:Burst
Length","16"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Burst Length"

WB:DQ/DQS Phase Alignment:Strobe High TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe High","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe High"

WB:DQ/DQS Phase Alignment:Strobe Mid TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Mid","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Mid"

WB:DQ/DQS Phase Alignment:Strobe Low TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Low","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Strobe Low"

WB:DQ/DQS Phase Alignment:Data High TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Data High","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data High"

WB:DQ/DQS Phase Alignment:Data Mid TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Mid","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Mid"

WB:DQ/DQS Phase Alignment:Data Low TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Low","5"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Data Low"

WB:DQ/DQS Phase Alignment:Hysteresis TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Hysteresis","50"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Hysteresis"

WB:DQ/DQS Phase Alignment:Margin TEKEXP:VALUE
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin","0"

TEKEXP:VALUE?
GENERAL,"WB:DQ/DQS Phase
Alignment:Margin"

Read Burst:Burst Detection Level Type TEKEXP:VALUE GENERAL,"Read
Burst:Burst Detection Level
Type","Auto"

TEKEXP:VALUE? GENERAL,"Read
Burst:Burst Detection Level
Type"

Read Burst:tDQSQ TEKEXP:VALUE GENERAL,"Read
Burst:tDQSQ","Auto"

TEKEXP:VALUE? GENERAL,"Read
Burst:tDQSQ"

Read Burst:tDQSQ Value TEKEXP:VALUE GENERAL,"Read
Burst:tDQSQ Value","0"

TEKEXP:VALUE? GENERAL,"Read
Burst:tDQSQ Value"

Read Burst:Pre-amble Static (tWCK) TEKEXP:VALUE GENERAL,"Read
Burst:Pre-amble Static
(tWCK)","2"

TEKEXP:VALUE? GENERAL,"Read
Burst:Pre-amble Static
(tWCK)"

Read Burst:PreAmble Static Value TEKEXP:VALUE GENERAL,"Read
Burst:PreAmble Static
Value","2"

TEKEXP:VALUE? GENERAL,"Read
Burst:PreAmble Static
Value"
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Read Burst:Pre-amble Toggle (tWCK) NA TEKEXP:VALUE? GENERAL,"Read

Burst:Pre-amble Toggle
(tWCK)"

Read Burst:Post-amble Length (tCK) TEKEXP:VALUE GENERAL,"Read
Burst:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE? GENERAL,"Read
Burst:Post-amble Length
(tCK)"

Read Burst:Postamble Mode TEKEXP:VALUE GENERAL,"Read
Burst:Postamble
Mode","Static"

TEKEXP:VALUE? GENERAL,"Read
Burst:Postamble Mode"

Read Burst:Burst Length TEKEXP:VALUE GENERAL,"Read
Burst:Burst Length","16"

TEKEXP:VALUE? GENERAL,"Read
Burst:Burst Length"

Read Burst:Strobe High TEKEXP:VALUE GENERAL,"Read
Burst:Strobe High","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe High"

Read Burst:Strobe Mid TEKEXP:VALUE GENERAL,"Read
Burst:Strobe Mid","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe Mid"

Read Burst:Strobe Low TEKEXP:VALUE GENERAL,"Read
Burst:Strobe Low","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Strobe Low"

Read Burst:Data High TEKEXP:VALUE GENERAL,"Read
Burst:Data High","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data High"

Read Burst:Data Mid TEKEXP:VALUE GENERAL,"Read
Burst:Data Mid","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data Mid"

Read Burst:Data Low TEKEXP:VALUE GENERAL,"Read
Burst:Data Low","1.1"

TEKEXP:VALUE? GENERAL,"Read
Burst:Data Low"

Read Burst:Hysteresis TEKEXP:VALUE GENERAL,"Read
Burst:Hysteresis","20"

TEKEXP:VALUE? GENERAL,"Read
Burst:Hysteresis"

Read Burst:Margin TEKEXP:VALUE GENERAL,"Read
Burst:Margin","0"

TEKEXP:VALUE? GENERAL,"Read
Burst:Margin"

Write Burst:Burst Detection Level Type TEKEXP:VALUE GENERAL,"Write
Burst:Burst Detection Level
Type","Auto"

TEKEXP:VALUE?
GENERAL,"Write Burst:Burst
Detection Level Type"

Write Burst:Pre-amble Static (tCK) NA TEKEXP:VALUE?
GENERAL,"Write Burst:Pre-
amble Static (tCK)"

Write Burst:Pre-amble Toggle (tCK) NA TEKEXP:VALUE?
GENERAL,"Write Burst:Pre-
amble Toggle (tCK)"

Write Burst:Post-amble Length (tCK) TEKEXP:VALUE GENERAL,"Write
Burst:Post-amble Length
(tCK)","0.5"

TEKEXP:VALUE?
GENERAL,"Write Burst:Post-
amble Length (tCK)"

Write Burst:Burst Length TEKEXP:VALUE GENERAL,"Write
Burst:Burst Length","16"

TEKEXP:VALUE?
GENERAL,"Write Burst:Burst
Length"
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ParameterName Example to set Example to query
Write Burst:tWCK2DQI Type TEKEXP:VALUE GENERAL,"Write

Burst:tWCK2DQI Type","Auto"
TEKEXP:VALUE?
GENERAL,"Write
Burst:tWCK2DQI Type"

Write Burst:tWCK2DQI Value (ps) TEKEXP:VALUE GENERAL,"Write
Burst:tWCK2DQI Value
(ps)","0"

TEKEXP:VALUE?
GENERAL,"Write
Burst:tWCK2DQI Value (ps)"

Write Burst:Strobe High TEKEXP:VALUE GENERAL,"Write
Burst:Strobe High","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
High"

Write Burst:Strobe Mid TEKEXP:VALUE GENERAL,"Write
Burst:Strobe Mid","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
Mid"

Write Burst:Strobe Low TEKEXP:VALUE GENERAL,"Write
Burst:Strobe Low","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Strobe
Low"

Write Burst:Data High TEKEXP:VALUE GENERAL,"Write
Burst:Data High","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
High"

Write Burst:Data Mid TEKEXP:VALUE GENERAL,"Write
Burst:Data Mid","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
Mid"

Write Burst:Data Low TEKEXP:VALUE GENERAL,"Write
Burst:Data Low","1.1"

TEKEXP:VALUE?
GENERAL,"Write Burst:Data
Low"

Write Burst:Hysteresis TEKEXP:VALUE GENERAL,"Write
Burst:Hysteresis","0"

TEKEXP:VALUE?
GENERAL,"Write
Burst:Hysteresis"

Write Burst:Margin TEKEXP:VALUE GENERAL,"Write
Burst:Margin","0"

TEKEXP:VALUE?
GENERAL,"Write
Burst:Margin"

Record Length (mpts) TEKEXP:VALUE
GENERAL,"Record Length
(mpts)","100"

TEKEXP:VALUE?
GENERAL,"Record Length
(mpts)"

Sample Rate (GS/s) TEKEXP:VALUE
GENERAL,"Sample Rate (GS/
s)","50"

TEKEXP:VALUE?
GENERAL,"Sample Rate
(GS/s)"

Bandwidth TEKEXP:VALUE
GENERAL,"Bandwidth","8"

TEKEXP:VALUE?
GENERAL,"Bandwidth"

Number of Runs TEKEXP:VALUE
GENERAL,"Number of
Runs","2"

TEKEXP:VALUE?
GENERAL,"Number of Runs"

Run Test More than Once TEKEXP:VALUE GENERAL,"Run
Test More than Once","TRUE"

TEKEXP:VALUE? GENERAL,"Run
Test More than Once"

Table continued…
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ParameterName Example to set Example to query
Enable Logging TEKEXP:VALUE

GENERAL,"Enable
Logging","TRUE"

TEKEXP:VALUE?
GENERAL,"Enable Logging"

Single-ended mode TEKEXP:VALUE
GENERAL,"Single-ended
mode","TRUE"

TEKEXP:VALUE?
GENERAL,"Single-ended mode"

Clock Signal Probe Type TEKEXP:VALUE GENERAL,"Clock
Signal Probe
Type","Differential"

TEKEXP:VALUE?
GENERAL,"Clock Signal Probe
Type"

WCK RDQS Signal Probe Type TEKEXP:VALUE GENERAL,"WCK
RDQS Signal Probe
Type","Differential"

TEKEXP:VALUE? GENERAL,"WCK
RDQS Signal Probe Type"

Visual Search Burst Detection Area TEKEXP:VALUE
GENERAL,"Visual Search
Burst Detection
Area","Define visual
trigger area on the screen"

TEKEXP:VALUE?
GENERAL,"Visual Search
Burst Detection Area"

VT Setup File TEKEXP:VALUE GENERAL,"VT
Setup File","C:\Program
Files\Tektronix\TekExpress\
TekExpress DDR Tx"

TEKEXP:VALUE? GENERAL,"VT
Setup File"

DeEmbed Filter Files TEKEXP:VALUE
GENERAL,"DeEmbed Filter
Files","Enable"

TEKEXP:VALUE?
GENERAL,"DeEmbed Filter
Files"

Retain Vertical Scale TEKEXP:VALUE
GENERAL,"Retain Vertical
Scale","True"

TEKEXP:VALUE?
GENERAL,"Retain Vertical
Scale"

WCK Probe Mode TEKEXP:VALUE GENERAL,"WCK
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"WCK
Probe Mode"

RDQS Probe Mode TEKEXP:VALUE GENERAL,"RDQS
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"RDQS
Probe Mode"

WCK(+) Probe Mode TEKEXP:VALUE
GENERAL,"WCK(+) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"WCK(+) Probe Mode"

WCK(-) Probe Mode TEKEXP:VALUE
GENERAL,"WCK(-) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"WCK(-) Probe Mode"

RDQS(+) Probe Mode TEKEXP:VALUE
GENERAL,"RDQS(+) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"RDQS(+) Probe
Mode"

RDQS(-) Probe Mode TEKEXP:VALUE
GENERAL,"RDQS(-) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"RDQS(-) Probe
Mode"

CA#a Probe Mode TEKEXP:VALUE GENERAL,"CA#a
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"CA#a
Probe Mode"
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ParameterName Example to set Example to query
CA#b Probe Mode TEKEXP:VALUE GENERAL,"CA#b

Probe Mode","A"
TEKEXP:VALUE? GENERAL,"CA#b
Probe Mode"

CS Probe Mode TEKEXP:VALUE GENERAL,"CS
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"CS
Probe Mode"

Clock Probe Mode TEKEXP:VALUE GENERAL,"Clock
Probe Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock Probe Mode"

DQ Probe Mode TEKEXP:VALUE GENERAL,"DQ
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"DQ
Probe Mode"

DQy Probe Mode TEKEXP:VALUE GENERAL,"DQy
Probe Mode","A"

TEKEXP:VALUE? GENERAL,"DQy
Probe Mode"

Clock(+) Probe Mode TEKEXP:VALUE
GENERAL,"Clock(+) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock(+) Probe
Mode"

Clock(-) Probe Mode TEKEXP:VALUE
GENERAL,"Clock(-) Probe
Mode","A"

TEKEXP:VALUE?
GENERAL,"Clock(-) Probe
Mode"

CA#a Connected to TEKEXP:VALUE GENERAL,"CA#a
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"CA#a
Connected to"

CA#b Connected to TEKEXP:VALUE GENERAL,"CA#b
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"CA#b
Connected to"

CS Connected to TEKEXP:VALUE GENERAL,"CS
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"CS
Connected to"

RDQS Connected to TEKEXP:VALUE GENERAL,"RDQS
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"RDQS
Connected to"

RDQS(+) Connected to TEKEXP:VALUE
GENERAL,"RDQS(+) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"RDQS(+) Connected
to"

RDQS(-) Connected to TEKEXP:VALUE
GENERAL,"RDQS(-) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"RDQS(-) Connected
to"

DQy Connected to TEKEXP:VALUE GENERAL,"DQy
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"DQy
Connected to"

DQ Connected to TEKEXP:VALUE GENERAL,"DQ
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"DQ
Connected to"

WCK Connected to TEKEXP:VALUE GENERAL,"WCK
Connected to","CH1"

TEKEXP:VALUE? GENERAL,"WCK
Connected to"

WCK(+) Connected to TEKEXP:VALUE
GENERAL,"WCK(+) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"WCK(+) Connected
to"

WCK(-) Connected to TEKEXP:VALUE
GENERAL,"WCK(-) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"WCK(-) Connected
to"
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ParameterName Example to set Example to query
Clock Connected to TEKEXP:VALUE GENERAL,"Clock

Connected to","CH1"
TEKEXP:VALUE?
GENERAL,"Clock Connected
to"

Clock(+) Connected to TEKEXP:VALUE
GENERAL,"Clock(+) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"Clock(+) Connected
to"

Clock(-) Connected to TEKEXP:VALUE
GENERAL,"Clock(-) Connected
to","CH1"

TEKEXP:VALUE?
GENERAL,"Clock(-) Connected
to"
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Application directories
You can find the application files at C:\Program Files\Tektronix\<Application Name>. The application directory and associated files are
organized as follows:

The following table lists the default directory names and their usage:

Table 31: Application directories and usage

Directory names Usage

Bin Contains application libraries

Compliance Suites Contains test suite specific files

Examples Contains various support files

ICP Contains instrument and application specific interface libraries

Images Contains images of the application

Lib Contains utility files specific to the application

Report Generator Contains style sheets for report generation

Tools Contains instrument and application specific files
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File name extensions
The TekExpress <Application Name> software uses the following file name extensions:

Table 32: File name extension

File name extension Description
*.TekX Application session files (the extensions may not be displayed)
*.py Python sequence file.
*.xml Test-specific configuration information (encrypted) files.

Application log files

*.csv Test result reports

Plot data

*.mht Test result reports (default)

Test reports can also be saved in HTML format

*.pdf Test result reports

Application help document

*.xslt Style sheet used to generate reports
*.png Captured images

View test-related files
Files related to tests are stored in My Documents\<Application Name>\Untitled session folder. Each test setup in this folder has both a test
setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the TekExpress icon.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default is DUT001.

Inside the DUT001 folder are the session folders and files. Each session also has a folder and file pair, both named for the test session
using the naming convention (date)_(time). Each session file is stored outside its matching session folder:

Each session folder contains image files of any plots generated from running the test session. If you selected to save all waveforms or ran
tests using prerecorded waveform files, these are included here.
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The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at X: \<Application Name>.
When you name and save the session, the files are placed in a folder with the name that you specify. A copy of the test files stay in the
Untitled Session folder until you run a new test or until you close the application.

DDR DFE standalone application
DDR5 DFE Overview
DDR5 supports data rates from 3200 MT/s to 6400 MT/s. This increase in the data rate is realized without the need for differential signaling
at the DQ pins i.e. the DQ bus is single-ended – same as DDR3/4.

However, due to the many impedance mismatched points that exist along the memory subsystem, ISI due to reflections are expected to
increase. At data rates >= 4800MT/s, the data eye at the DRAM ball is expected to be closed. A 4-tap DFE is implemented in the DDR5
DRAM Rx to help equalize the DQ signals and open the data eyes after the data is latched by the receiver.

DDR DFE Introduction
The DDR DFE is a standalone software application in Tektronix’s performance scopes. It is used to perform 4 tap DFE operation on the
DDR5 write burst signals coming from the DDR5 DUTs.

How to launch
Install TekExpress DDR Tx on the oscilloscope. Click TekScope > Analyze Menu > DDR DFE.

DDR DFE Application
Burst Detection Settings

Once the “DDR DFE” is launched, in the ‘Burst Detection Settings’ tab, user must select ‘Strobe DQS’ and ‘Data DQ’ signals coming from
the DUT connected to the oscilloscope channels. The user must configure the ‘DFE Output’ to the required Math channel. The user must
set the ‘Data Rate’ of the DDR5 of the DUT. The waveform edges are selected based on ‘Ref Levels’ [High, Mid, and Low]. The application
will calculate the reference level automatically when ref levels are set to “Auto”. The application will calculate separate High, Mid, Low
values for ‘Data DQ’ and ‘Strobe DQS’.

When the ‘Ref Levels’ are modified from Auto to Custom, they can be modified as per user choice. The application will use the reference
level set by the user when input levels are set to “Custom”. Similarly, ‘Clock Delay’ can be modified as per user choice. The clock delay is
timing delay between DQS to DQ, the delay is used in clock recovery.

DFE Settings tab
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The DFE Setting tab will allow the user to define the Gain and Tap values for Tap1, Tap2, Tap3, and Tap4. The gain control of the front end
is used to ensure that the cursor or the current bit is in a congruent relationship with the ISI correction required for the channel. The taps
T1, T2, T3, T4 coefficients provide the corrections needed to the current bit by adding or subtracting the effects of ISI of the previous bits.

The Gain is applied to the waveform along the 4 tap DFE tap values. The limits of the Gain and tap values are shown below. Note: Initial
Gain and DFE taps are each individually limited to the below range. Exact values (TBD) as will be determined upon release of JEDEC
specification.

Threshold is the middle voltage level of the signal, which may be the transition between logic levels. For biased signals, enter the mid-level
value.

Description Min Max Unit

DFE Gain -6 6 dB

DFE Tap 1 -200 50 mV

DFE Tap 2 -75 76 mV

DFE Tap 3 -60 60 mV

DFE Tap 4 -45 45 mV

Description Typical Unit

DFE Gain Avg Step Size 2 dB

DFE Tap Avg Step Size 5 mV

Apply the DFE Settings to Math

Click Apply to configure the Gain and Tap values configured in the Burst Detections Settings tab to the DFE Output. You can find the Math
output generating the DFE applied DQ waveform, which you can use with Strobe DQS for any of the measurements of your choice.

Note: Do not use DDR DFE while executing the Write Eye measurements in the TekExpress DDR Tx application.
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SDLA DDR5 Tutorial
This tutorial provides details on how to setup SDLA to model a DDR5 memory system test configuration. The DQS and DQ signals are
acquired through the oscilloscope probes that are soldered onto an interposer that fits between the memory chip and the circuit board.
The user can then setup S-parameter models for the probe, and interposer, and the memory system loading and transmission lines. The
goal is to create filters, that when applied to the acquired waveforms, de-embeds the effects of interposer and probe. Thus, accounting for
impedance mis-match and reflections.

SDLA overview

The overall purpose of SDLA is to allow the user to setup S-parameter models for the measurement system used to acquire signals
on an oscilloscope and for the simulation system. It will compute filters to apply to the input waveforms of the oscilloscope and provide
waveforms that would be represented by the various test points in the SDLA system model. SDLA also provides an Rx block model that
allows for simulation of CTLE, clock recovery, and FFE and DFE equalization filters.

Steps to install and launch SDLA application

1. Install the latest SDLA version on the oscilloscope.
2. To launch the application, select TekScope > Analyze > Serial Data Link Analysis

Follow the steps to launch the SDLA DDR5 Modeling Tutorial document.

1. To launch the application, select TekScope > Analyze > Serial Data Link Analysis
2. Click Rx in the SDLA menu.

Figure 32: SDLA Visualizer

3. In the SDLA Visualizer - Rx Configuration, select User and click the Config tab.

Figure 33: SDLA Visualizer - Rx Configuration

4. Select DDR5 from the CTLE Type drop-down menu.
5. Click ? button to open the SDLA help file.

Pre-recorded waveform file names for test measurements
The following table specifies the waveforms to load for the selected Acquire Type.
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Table 33: For DDR5

Acquire Type Waveforms to be loaded
Clock For differential signal probe type:

• DDR5-<DataRate>-Clock-Clock-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

For Single Ended Probe type:

• DDR5-<DataRate>-Clock-Clockc-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Clock-Clockt-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

WR_Data For differential signal probe type:

• DDR5-<DataRate>-Write-Data-DQ-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Write-Data-DQS-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Write-Data-Clock-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

For DFE enabled:

• DDR5-<DataRate>-Write-DFE-DQ-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

For single-ended probe type:

• DDR5-<DataRate>-Write-Data-DQSc-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Write-Data-DQSt-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

RD_Data • DDR5-<DataRate>-Read-Data-DQ-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Read-Data-DQS-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

• DDR5-<DataRate>-Read-Data-Clock-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

Address_Command • DDR5-<DataRate>-CA-CA-<RecordLength>-<SourceChannel>-
<RunIteration>.wfm

• DDR5-<DataRate>-CA-Clock-<RecordLength>-
<SourceChannel>-<RunIteration>.wfm

Table 34: For LPDDR5-5X

Acquire Type Waveforms to be loaded
Clock For differential signal probe type:
Table continued…
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Acquire Type Waveforms to be loaded

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Clock-Clock-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

For single-ended probe type:

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Clock-Clockt-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Clock-Clockc-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

Write_Clock For differential signal probe type:

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Clock-WCK-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

For single-ended probe type:

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Clock-WCKt-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Clock-WCKc-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

WR_Data For differential signal probe type:

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-Clock-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-DQ-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-WCK-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

For single-ended probe type:

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-WCKt-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-WCKc-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

WR_Data_tDQ2DQ • LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-tDQ2DQ-
DQy-<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-tDQ2DQ-
DQ-<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Write-Data-tDQ2DQ-
WCK-<RecordLength>-<SourceChannel>-<RunIteration>.wfm

RD_Data • LPDDR5-5X-<DataRate>-<WCKtoCK>-Read-Data-DQ-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-Read-Data-RDQS-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

Table continued…
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Acquire Type Waveforms to be loaded
CA • LPDDR5-5X-<DataRate>-<WCKtoCK>-CA-Clock-

<RecordLength>-<SourceChannel>-<RunIteration>.wfm
• LPDDR5-5X-<DataRate>-<WCKtoCK>-CA-CAa-

<RecordLength>-<SourceChannel>-<RunIteration>.wfm

CA_tCA2CA • LPDDR5-5X-<DataRate>-<WCKtoCK>-CA-tCA2CA-CAa-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-CA-tCA2CA-CAb-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-CA-tCA2CA-Clock-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

CS • LPDDR5-5X-<DataRate>-<WCKtoCK>-CS-Clock-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm

• LPDDR5-5X-<DataRate>-<WCKtoCK>-CS-CS-
<RecordLength>-<SourceChannel>-<RunIteration>.wfm
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